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Abstract

Semi-Markov models can be used to analyze the reliability of virtually any fault-tolerant

system. However, the process of delineating all of the states and transitions in the model

of a complex system can be devastatingly tedious and error-prone. Even with tools such
as the Abstract Semi-Markov Specification Interface to the SURE Tool (ASSIST), the

user must describe a system by specifying the rules governing the behavior of the system in

order to generate the model. With the Table Oriented Translator to the ASSIST Language

(TOTAL), the user can specify the components of a typical system and their attributes in
the form of a table. The conditions that lead to system failure are also listed in a tabular

form. The user can also abstractly specify dependencies with causes and effects. The level

of information required is appropriate for system designers with little or no background

in the details of reliability calculations. A menu-driven interface guides the user through

the system description process, and the program updates the tables as new information is

entered. The TOTAL program automatically generates an ASSIST input description to

match the system description.
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1 Introduction

The Table-Oriented Translator to the ASSIST Language (TOTAL) computer program is a proto-

type spreadsheet interface for a reliability analysis tool set developed at NASA Langley. The tool

set began with the development of several Markov and semi-Markov model solvers, which pro-

vide the flexibility to represent the failure behavior of virtually any fault-tolerant system. These

include the Semi-Markov Unreliability Range Evaluator (SURE), the Scaled Taylor Exponential

Matrix (STEM) solver, and the Pad_ Approximation With Scaling (PAWS) program[l, 2, 3].

Since the enumeration by hand of the states and transitions of the Markov model is only tractable

for the simplest of systems, the ASSIST language was developed to allow the user to describe

the failure behavior of the system in a high-level abstract language[4]. The ASSIST computer

program was then developed to use the ASSIST description as a set of rules for automatically

generating a reliability model[5]. The ASSIST program simply follows the rules as specified

by the user and makes no assumptions about the system, so ASSIST is completely general

and could theoretically be used to generate a reliability model for virtually any fault-tolerant

system. However, the user must learn the concepts and syntax of the ASSIST input language

before he can use it, and validation that the ASSIST description is accurate can be difficult for

fault-tolerant systems with complex failure properties and dependencies.

The TOTAL interface program allows the user to describe a system at an even higher level of

abstraction. Instead of providing the complete flexibility of the ASSIST language, the TOTAL

interface provides the user with a structured set of choices for describing the system components

and their interactions. The flow of information between the computer programs in this tool set

is shown in Figure 1.

Spreadsheet| l Abstract l I Semi-Markov I l
System _ TOTAL_-'_ Language _ ASSIST_--_ Reliability----_ SURE _ Reliability

Description_Description l---.--.J Model _ Estimate

Figure 1: Reliability Analysis Tool Set

The simplest systems are non-reconfigurable ones whose system failure is based on what com-

binations of its components have failed. The failure behaviors of these systems can be fully

described by listing the components and their failure rates and enumerating which combinations

of component failures lead to system failure, such as is done in a fault tree. This description is

typically facilitated by grouping like components into subsystems.

Reconfigurable systems can be more complex to describe. Each subsystem may have spare

components that are brought into the active configuration to replace failed components. Once

the available spares are exhausted, a subsystem may degrade by removing failed components

from the voting process. The system may provide full or partial detection of failed spares.

Some spare components may be shared between subsystems and thus available to replace failed

components in one or more subsystems.

More complex systems may exhibit failure dependencies between components; for example,

failure of a power supply may cause the components dependent upon it to fail as well. A



processormay dependon a network elementfor communicationwith the other processors in

the system. Such dependencies can sometimes be included in the system failure combination

descriptions. However, it is often more convenient and concise to list these as separate failure

dependencies.

The level of system description given above seems appropriate for designers of fault-tolerant

systems, even those with no background knowledge in reliability analysis calculations. This is

the level of information needed to build a TOTAL system description. The user does not have to

know how to build reliability models; he only needs to know the failure behaviors of his system.

The TOTAL program provides a menu-driven interface to guide the user through each phase

of the system description. The system description consists of four parts: 1) a spreadsheet

describing the components in the system, 2) specification of the failure dependencies between

the components, 3) a description of the conditions representing system failure, and 4) a list of

sets of pooled spares that can be shared between the components in the system. As the menu-

driven interface guides the user through the system description process, the TOTAL program

interactively builds and displays the set of tables describing the system. Once the system

description process is complete, the user can generate the ASSIST-language description, execute

the ASSIST program to enumerate the states and transitions of the model, and solve for the

probability of system failure using the SURE, STEM, or PAWS programs, all from the TOTAL

menu-driven interface.

The TOTAL program was developed as a prototype system to explore and demonstrate the

feasiblity of a spreadsheet interface for reliability analysis. The prototype was developed and
beta-tested with a limited menu-driven interface and no direct input to the displayed tables.

If development were to continue, later versions of TOTAL would allow the user to directly

input and manipulate data in the tables, and the TOTAL spreadsheet program would maintain

consistency between tables. With these capabilities, the novice user would be guided in the

system description process by the easy-to-follow menu interface, while the more experienced

user would be able to efficiently enter data directly into the spreadsheet tables.

The TOTAL prototype cannot be considered a commercial-quality tool. The program was

subjected to a moderate amount of testing inhouse plus a minimal amount of beta testing.

Thus, the user is cautioned to examine the generated ASSIST-language description to validate

that it is a reasonable representation of the intended system.

The menu-driven interface for the Version 1.0 prototype of TOTAL is introduced in Chapter

2. The details of how to use the interface to enter a system description are described and

demonstrated for an example system in Chapter 3. Chapter 4 discusses generation and solution

of the Markov model in general. Chapter 5 details the specific rules that are applied when

generating the state transitions and the model. Chapter 6 details the system requirements for

the TOTAL program, followed by some concluding remarks.
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2 The TOTAL Interface

The menu-driven interface available in TOTAL Version 1.0 is introduced in this section. The

user enters the interactive interface by entering the command "total". The user can modify the

TOTAL program to accommodate large or unusual system descriptions using the command-line

options shown in Appendix A. Upon entering TOTAL, the System Description panel shown

in Figure 2 is displayed on the user's workstation. The figures in this manual show the panels

as they are displayed on a SUN OS system running Motif. The panels displayed on a VMS

computer contain the same information and "feel" the same but may look slightly different.

)oolname size

Spare Pools:

_$NNNH_N_Hmu'_i_M_H_IHuHmHiIH_d_/i_tdwii_da_,._{T_£_`__H_i__rdNH_I_

fa i lure-rat e prob-of-det ect ion

DR
D

lame redund ;rans/int _egrad dedicated-spares )ools:
Components:

condition: cause -> effect
Dependencies:

System Failure

Conditions:

Figure 2: System Description Panel

This panel contains four tables for displaying the system description:

• Spare Pools

• Components

• Dependencies

• System Failure Conditions.

The Spare Pools table holds the descriptions of any pools of spare components that can be used

to replace failed components. The Components table describes the components in the system.



Each line of the table representsonesubsystemof the system,wherea subsystemis madeup of
like components.Any failure dependenciesaredepictedin the Dependenciestable. Finally, the
SystemFailureConditions table lists the conditionsthat are to bemodeledasdenoting system
failure.

Besideeach table is an "Edit" pull-down menu, representedas a rectangle1, for entering or
modifying entries in that table. The userdisplaysthe pull-down menuby moving the mouse
cursor over the Edit pull-down menu and pressing and holding down the left mouse button.

Figure 3 shows the user selecting the Append option from the Edit pull-down menu for the

Components table.

OepenN _or_LtLon: ¢eulo -> effect

[]

_.lm FWlure

Cor_V_n_:

El
[] M

Figure 3: Using Edit Pull-Down Menu to Append a New Component

Each pull-down menu contains five options:

Append

Copy

Delete

Insert

Modify

Add a new entry to the end of the table

Create a new entry after a specified entry by modifying

a copy of that entry description

Delete an entry

Insert a new entry before a specified entry

Modify an existing entry

While still holding down the left mouse button, the user selects an option by moving the mouse

over the selection. When the user releases the left mouse button, a new menu panel correspond-

ing to the option selected will appear on the screen. The user must use the Append option (and

not the Insert option) to input the first entry in each table.

The System Description Panel also contains two additional pull-down menus: the File menu

and the "Opt's" or Options menu. The File menu contains the following functions:

tOn color terminals the pull-down menu rectangles are yellow



Erase

New

Old

S ave

Save As

Generate ASSIST

Edit ASSIST

Run

Edit Output

Delete

Batch

Quit

Delete all existing entries in the current system description

- Delete all existing entries in the current system description and

assign a new name to the current system description

- Delete all existing entries in the current system description and

read in a system description from a file

Save the current system description in a file under the current

name

Save the current system description under the specified name

Generate an ASSIST input description from the current system

description

Edit the generated ASSIST file using EVE under VMS or

vi under Unix 2

Generate the model using ASSIST and solve the model using

SURE

- Edit the generated SURE output file as produced by the "Run"

option.

- Delete the specified system description file

Read in a set of TOTAL instructions from a batch file

Exit the TOTAL program

Figure 4 shows the user selecting to read an old file from the File menu.

Edit Output

Deleo

Figure 4: Using "File" pull-down menu

Once the system description is complete, the user should save the model with the "Save" or

"Save As" function from the "File" m¢nu before quitting. These functions copy the model

description from the computer memory onto the disk file. Any model in memory when the user

'the EMACS editor is used when the -ema command line option is given



exits TOTAL or the systemgoesdownwill be lost forever. If the model is savedon a disk file,

it will remain even if the computer is turned off.

If the user decides to quit without saving the model, TOTAL will protest as shown in Figure

5. The TOTAL program knows when a change has been made because the user had to click

on an "Okay" button from some description panel in order to make a change. The program

disallows the user from quitting or calling up another model with the "Old" function from the

"File" menu until the old model has either been saved or erased.

m

C_'mr_ponents _m baRbtw4u w_t_d. II_m_ m R_. 6.1t3,-4 0.66 57

El

_nditSon: cJuse -> eff_t
Dependenclts:

R_(processors[I]) -> R]gq(aagortes l )
R_(ptocessors[2]) -> R_(_morto$ 2 )

Rl_(procossors[3]) -> R_(_ries[31)

[]

System F _k,_e lATH I F NAJ (ptoclssors)
Conditions: _,_L21-11F MJ_Y ( 114too r t elO

F_l D_THIW _(i_s)

[]

I{

Figure 5: Cannot quit until changes saved

If the user decides to erase the changes entirely, the "File" menu is pulled down to the "Erase"

function. The system verifies that the user really wants to erase the system from memory as

illustrated in Figure 6.

As shown in Figure 7, the Options Menu contains the following three options:

• Set Code Generation Options/Values

• Show System Definitions

• System Description Comments and/or Remarks

Figure 7 shows the user selecting the option to "Show System Definitions" from the "Opt's"

options menu.

As the user describes his system using the menus, the system description is displayed in the

tables. The text in the tables can extend past the right edge or the bottom of the tables, and

this data can be viewed by scrolling each table using the scroll bars provided. Although tables

can be scrolled, the text in the tables is static and cannot be entered or modified directly in

Version 1.



Figure 6: System verifies Erase option before taking action

Figure 7: Using pull-down menu to show system definitions



3 Example System Description

In this section, the TOTAL menu-driven interface will be described and illustrated by way of

example. The example system consists of a triplex set of processors with one spare processor,

a triplex set of memory units, and a quadruplex bus, as shown in Figure 8. All messages

and calculations performed in the system are subject to majority voting to detect and mask

failures. Thus, a majority of the processors in the current configuration must be working, or

system failure occurs. Similarly, a majority of the memories and a majority of the buses must

be working. Upon detection of the first processor failure, the spare processor is brought into

the configuration to replace the faulty processor. Upon the second processor failure, the faulty

processor is removed and the remaining two working processors continue in duplex mode. Failure

of one of the remaining two processors is assumed to immediately defeat the majority voter.

Each memory unit is attached to one of the processors, and removal of a failed processor also

results in removal of its attached memory. The memory units degrade from triplex to duplex

to simplex as failed memory units are detected in the configuration or are removed because of

processor removals. The bus is non-reconfigurable.

PROC

MEM

I
PROC

Figure 8: Example System

During the system description process, the user assigns names to identify the components in

his system and defines any extra constants or state-space variables he might need. Except for

special identifiers that are used by ASSIST and SURE, these identifiers are only meaningful

to the user--the TOTAL program makes no implicit distinction between the behavior of a

"processor" component, a "bus," or a "foobar." The user can input all rates and times to the



programin whateverunits (hours,minutes,...) hewishes,as long ashe is consistent. However,
the default mission time in SURE is 10 and must be changedif 10 units is not the desired
missiontime. The changecan bemadeby editing the ASSIST output file to define "TIME =
value;" after generating it and before running it.

The following subsections detail how this example system can be described using the TOTAL
interface.

3.1 Spare Pools

Spare pools are pools of spare components that can be used to replace multiple types of failed

components. Consider, for example, a system that contains two triads of processors that share

a pool of spare processors. The spare processors would be described in the Spare Pools table

and given a name, such as "pspares". The two triads would then be described as two separate

component types in the Components Table, and each would have "pspares" listed as a source

of pooled spares.

The menu used for describing a pool of spares is shown in Figure 9. The inputs are as follows:

• Poolname _ Name of the pool, maximum 8 characters

• Size _ Number of components in pool initially

• Failure rate _ Failure rate for components while spares

• Probability of detection _ Probability that a failure will be detected before the com-

ponent is brought into an active configuration (note that this shows up only when the

detectability is set to "Partially". See Figure 11.

i_liiiNJJJiliU_iJililifii_JWfliliiiJilt_i_JJJililiJUiJifiliJJJiJ$i_JU_L_ o1""_i_hJiiJlJfl]lJJiliJHW_i_JHtlititiltJfltt$iRlllJlllll_WIi_lt|

pool name:I I detectability:
4_ Never _ Partially <_ Fully

poolsize: _ 1

Failure rate:

Figure 9: Menu Panel for Describing Pool of Spares

Since our example system does not contain any spare components that are shared between more

than one subsystem, the system description will not contain any spare pools.



3.2 Components

The example system description will contain three entries in the Components table: processors,

memories, and the bus channels. To input the first entry, select the Append option from the

Edit menu beside the Components table. Figure 10 shows the component configuration panel

filled in with the correct information to describe the processors subsystem.

repetition factor: I 1 ,]

Component Name: I processors ,I

redundancy count: [ 3 I

k,

cletectability:

0 Never _ Partially 4k Fully

Failure rate:

Figure 10: Component configuration for "processors"

The menu panel selection fields are as follows:

• Repetition Factor _ Number of subsystems of this type. The repetition feature is not

supported in Version 1.0, so the default value of 1 must be used. In later versions, this

will provide a convenient way to specify systems containing multiple similar subsystems,

such as systems with multiple triads.

• Component Name _ Name used to identify this subsystem. May be as long as 16

characters, however, the first 8 characters 3 should be unique.

3TOTAL generates constant identifiers by using various prefixes of up to four characters each for constants.

The SURE program requires the first 12 characters of an identifier to be unique. Although some IMPLICIT

prefixes are five characters long, these do not affect the SURE model file, so eight unique characters for a name

guarantees uniqueness of the model.
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• RedundancyCount _ Numberof componentsin eachsubsystemof this type.

• Degradable _ Description of how this component degrades when component failures

occur after any available spares have been exhausted. One of the following predefined

degradation strategies must be chosen. The default is Non-degradable.

- Non-degradable _ No components are ever removed from the subsystem.

- Triplex to duplex to simplex _ Components are removed from the subsystem one

at a time as they fail. Thus for a hexad, this selection would be hexad to quintad to

quadruplex to triplex to duplex to simplex.

- Triplex to simplex _ Components are removed from the subsystem one at a time

as they fail until a triplex is reached. Failure of one component of a triplex results in

removal of the failed component plus one other component, leaving a simplex. Thus

for a hexad, this selection would be hexad to quintad to quadruplex to triplex to

simplex.

- Duplex to zero _ Components are removed from the subsystem one at a time until a

duplex is reached. On the next component failure, all of the components are removed.

Thus for a hexad, this selection would be hexad to quintad to quadruplex to triplex

to duplex to zero. This selection is useful for self-checking pairs.

The logic and mathematics for degradable components is discussed in detail in Section 5.2

on page 42.

• Transients? _ Select this box if you wish to model transient faults as well as permanent

faults.

• Intermittents? _ Intermittents are not supported in Version 1.0.

• Dedicated Spare Count _ The number of spares dedicated to this subsystem only. Note

that dedicated spares cannot be shared across replicated subsystems; they are dedicated

to a specific subsystem. Dedicated spares will be substituted for failed components before

pooled spares. The logic and mathematics for spares is discussed in detail in Section 5.1

on page 41.

• Primary Spare Pool _ If failed components of this subsystem can be replaced by spare

components from a spare pool, the name of the first pool they will be taken from is listed

here. Any dedicated spares for this subsystem will be used before the primary spare pool.

The logic and mathematics for spares is discussed in detail in Section 5.1 on page 41.

• Secondary Spare Pool _ If the name of a secondary spare pool is given here, then after

the subsystem has used all of its dedicated spares and primary pool spares, then subsequent

failed components will be replaced with components from the secondary spare pool. The

logic and mathematics for spares is discussed in detail in Section 5.1 on page 41.

• Tertiary Spare Pool _ This is the name of the third spare pool to be used after all

dedicated, primary pool, and secondary pool components are exhausted. The logic and

mathematics for spares is discussed in detail in Section 5.1 on page 41.

11



Since there is only one set of triplex processors in our example system, the repetition factor

is 1. The component name of "processors" is entered. The redundancy count is 3 because

there are 3 components in the "processor" subsystem. The subsystem always degrades by one,

so degradation from "triplex to duplex to simplex" is selected. Permanent faults are always

modeled, and for this subsystem modeling of transient faults is also selected. Since there is one

spare processor, the dedicated spare count is 1. As soon as a non-zero dedicated spare count

is chosen, another panel appears for describing the dedicated spares for that subsystem. The

Dedicated Spare Details panel contains the following items:

• Detectability ---* Whether the system can detect that spares have failed and remove them

from the available spares is specified by choosing one of the following:

- Never _ The probability of detection that a spare has failed is zero.

- Partially _ If this selection is chosen, an additional panel immediately appears for

the user to input the probability of detection, as shown in Figure 11.

- Fully _ The probability of detection that a spare has failed is one; i.e. the system

can determine with 100% success that a failed spare is bad and will not use it.

• Failure rate _ The failure rate for dedicated spares.

Figure 11: Partially detectable dedicated spare failures

For our example system, tile spare is assigned an exponential failure rate 4 of 6.113 x 10 -4, and

"Fully" detectability is chosen because it is assumed for this system that failures of the spare

are always immediately detected. The example system contains no pooled spares, so no spare

pool names are specified.

After clicking on the "Okay" button, a panel appears for specifying the rates pertinent to this

subsystem, as shown in Figure 12. The items that can appear in the panel are as follows:

• Permanent fault arrival _ The exponentially distributed arrival rate for permanent faults

for this component type.

4All rates must be input in "e" exponential format. For example, 6.113 x 10.4 must be input as 6.113e - 4.

12



Rate to remove and/or break up _ The rate to degrade the subsystem configuration as

specified in the "Degradable" section of the Component Configuration panel once all spare

components have been exhausted.

Rate to reconfigure in a spare _ The rate to replace a failed component with either a

dedicated spare or a pooled spare.

Transient fault arrival ----, The exponentially distributed arrival rate for transient faults

for this component type.

Transient fault disappearance rate _ The rate at which transient faults and their effects

disappear from the system for this component type.

The user will only be prompted for the items that pertain to the subsystem specified; for

example, the user will only be prompted for transient fault arrival and disappearance rates if

he specified that transients faults were to be modeled. Permanent and transient fault arrival

rates are slow exponential rates, and are defined by simply giving a rate in real or exponential

notation, such as "le-4". The rates for degradation, reconfiguration to bring in a spare, or

disappearance of transient faults are fast rates. These fast rates may be given in one of two

formats: 1) by giving the mean and standard deviation of the distribution within angle brackets,

such as "< 3.6e - 3, 3e - 3 >", or 2) by simply giving the rate for an exponentially distributed

transition, such as "6.5e5". If the rate is given, the mean and standard deviation used for this

transition will both be equal to the inverse of this rate. Figure 12 shows the specification of

rates for component "processors" of the example system.

For any component type that can fail with transients, all reconfiguration rates must be input

by giving rates for exponential distributions. This is necessary because TOTAL cannot model

competing nonexponential transitions, and this requirement is enforced by the rates panel.

After clicking on the "Okay" button on the rates panel, the component specification menus will

disappear and all changes will be reflected in the tables.

The memories and bus subsystems are specified in a similar manner. The memories subsystem

description is identical to the components specification, except that the dedicated spare count is

not set to 1. To specify that there are no dedicated spares, the user can just leave the dedicated

spare count box empty (and TOTAL will use the default value of 0) or he can enter a 0 in the

box. Since the subsystem has no dedicated spares, the menu for specifying these details does

not appear.

The description for the bus subsystem is shown in Figure 13. Since the bus is a non-reconfigurable

quadruplex, the redundancy count is 4 and "Non-degradable" is chosen. Transients are not se-

lected since transient faults of the bus will not be modeled. The bus has no dedicated spares.

After clicking on the "Okay" button, the rate specification panel for the bus subsystem appears,

as shown in Figure 14. Since transient bus faults will not be modeled and the bus has no spares

and is non-degradable, the rate specification panel only prompts for the input of the permanent

failure rate for this component.
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Figure 13: Component configuration for "bus"
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3.3 Dependencies

The Dependencies section allows the user to specify any dependencies in the failure behaviors

between subsystems in the system. Each dependency has one or more triggering events and

one or more effects. A trigger event might be permanent or transient failure of a component,

replacement of a component with a spare, or removal of a component. An effect of a dependency

might be the failure or removal of a component, or the incrementing or decrementing of a value

in the model. As will be shown in a later section, the user can define extra state-space variables

to be included in the model. The user can then define dependencies that cause the values of

these variables to be changed. This can be useful for describing a system with various "modes"

of operation.

Dependencies can be either conditional or unconditional. Conditional dependencies are only in

effect under certain conditions of the system. Each dependency has exactly one cause and can

have either a single effect or multiple effects. For example, if we were to model a system in

which a processor was the master of a bus, then failure of that processor would cause (at least

temporary) failure of the bus.

There is one type of dependency that must be described about the example system--because

the memories are connected to the processors, removal of a faulty processor causes removal of

the memory unit attached to it. The dependency between each memory unit and its processor

must be specified; removal of processor 1 causes removal of memory 1, removal of processor 2

causes removal of memory 2, and removal of processor 3 causes removal of memory 3. These

dependencies are unconditional, because they are always in effect regardless of the system con-

figuration.

To describe the first dependency, select the "Append" option from the Edit menu next to the

Dependencies table, and the Dependency Specification panel will appear. This panel contains

the following items:

Conditional/Unconditional Buttons -----* Specifies whether this dependency is always in

effect (unconditional) or only in effect under certain conditions or configurations (condi-

tional). If Conditional is chosen, a menu appears for specifying the condition or set of

conditions under which this dependency is in effect.

Cause _ Specification of what conditions cause this dependent behavior to trigger. The

entries for specifying the cause are as follows:

- Component Name: ----* Name of component type.

- [,] _ Which component of this type triggers this dependency. Default is blank (un-

specified), which means that any component of this type can trigger this dependency.

- One of the following must be chosen to specify what behavior(s) of the specified

component causes the dependency to trigger:

* failure ----* Triggers on arrival of any applicable failure of the component (per-

manent or transient).
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* arrival of permanent _ Triggers on arrival of permanent failure of the com-

ponent. Since arrival of permanent includes both working-to-permanent and

transient-to-permanent transitions, this option can only be chosen if transient

faults are modeled for this component.

, arrival of transient _ Triggers on arrival of transient failure of the component.

, removal _ Triggers on removal of the component from the configuration because

of degradation. Replacement with a spare component is not considered removal

of the component.

, recovery ---* Triggers on replacement of the component with a dedicated or

pooled spare regardless of whether that spare swapped in is working or has failed.

Also triggers on degradation of the component by removal of a faulty component.

, disappearance of transient ---, Triggers on disappearance of transient failure

(and its effects) from the component.

. Effect X of Y _ Listing of effect(s) of this dependency. The X is the index of the effect

currently shown, and the Y is the total number of effects listed for this dependency. The

entries for specifying each effect are as follows:

- Component Name: ---* Name of component type or variable affected by this depen-

dency.

- [,] _ Index to component of this type (or variable array) that is affected by this

dependency. Default is blank (unspecified), which means that all components of this

type are affected with equal probability by this dependency. An equal sign ("=")

may also be used to indicate that the same index value is to be used as the index of

the component that triggered the dependency.

- If the effect is on a component (as opposed to a variable), one of the following must

be chosen to specify the effects of this dependency on this component:

, failure _ Causes the component to fail permanently.

, removal _ Causes the component to be removed from the current configura-

tion. The number active is always decreased with a removal effect, regardless of

whether of the presence of any spares. If the user desires a spare to be swapped

in, then a failure effect should be used instead. Transitions to replace failed

processors with spares are automatically generated by TOTAL when spares are

present in the system description.

, transient disappearance _ Causes the disappearance of any transient faults

currently experienced by this component.

- If the effect is on a variable (as opposed to a component), one of the following must

be chosen to specify the effects of this dependency on this variable:

, ++ _ Causes the value of the specified variable to be incremented by one.

, , Causes the value of the specified variable to be decremented by one.

, =0(false) ---* Causes the specified variable to be set to 0 if integer or to false if
Boolean.
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• =min _ Causes the specified variable to be set to the minimum value allowed

for the variable.

• =max _ Causes the specified variable to be set to the maximum value allowed

for the variable.

• =1(true) _ Causes the specified variable to be set to 1 if integer or to true if

Boolean.

The Dependencies panel also includes the following buttons:

• Quit _ Quit entering or editing this dependency without making the specified changes

• Last Effect _ Display the previous effect specified for this dependency (i.e. move from

displaying Effect M of N to displaying Effect M-1 of N).

• Next Effect _ Display the next effect of this dependency (i.e. move from displaying

Effect M of N to displaying Effect M+I of N).

• Edit _ Menu for appending, copying or deleting effects of this dependency.

The panel for specifying the conditions under which a dependency takes effect has the following

entries:

• Component Name _ Name of component type.

• [,] _ Which component of this type triggers this dependency. Default index is "="

or blank (not applicable), which means that any component of this type can trigger this

dependency.

• If an index is given, then one or more of the following must be chosen to specify the

condition of the specified component that must be effect for this dependency to occur:

- failed _ This dependency can only occur when the specified component has failed

(either permanent or transient) but is still in the active configuration (has not been

replaced by a working spare component or removed through degradation), s

- permanent fault _ This dependency can only occur when the specified component

has failed permanently but is still in the active configuration (has not been replaced

by a working spare component or removed through degradation). 6

- transient fault _ This dependency can only occur when the specified component

is experiencing a transient fault and is still in the active configuration (has not been

replaced by a working spare component or removed through degradation). 7

- removed _ This dependency can only occur when the specified component has been

removed from the active configuration through degradation, s

5FA[ix]
sFP[ix]
7FT[ix]
SNOT A[ix]
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• If an index is not given, then one of the following must be chosen to specify the condition

of the specified component that must be effect for this dependency to occur:

- majority vote failure --_ This dependency can occur only when a majority of the

active parts in the component have failed2

- exhaustion of parts _ This dependency can occur only when all of the parts in the

component have failed. 1°

- # working < n --_ This dependency can occur only when the number of working

parts in the component is less than "n". 11

- # removed > n --_ This dependency can occur only when the number of parts

removed from the component is greater than "n". The number of parts removed

from a component is defined to be the difference between the number initially and

the total active which remain in the configuration. 12

- # failed > n --_ This dependency can occur only when the number of failed parts

still active for the component is greater than "n'.13

- # permanent failed > n _ This dependency can occur only when the number of

permanent failed parts still active for the component is greater than "n". 14

- # transient failed > n ---+ This dependency can occur only when the number of

transient failed parts still active for the component is greater than "n".ls

- textual _ This dependency can occur only when the textual ASSIST syntax

Boolean expression holds true. The syntax of the expression is not checked for valid-

ity, however, TOTAL does enforce balancing of parentheses within the expression.

• n _ If one of the above bullets which reference a value for "n" is selected, then the value

to be used for "n" must be entered here.

• negate this one _ Causes the negation of this condition to be used, e.g. changes "#

working < n" to "not(# working < n)."

• negate whole IF condition _ Causes the negation of the entire IF. (e.g., "not ((#

working < n) and (transient fault))").

The Conditionals panel also includes the following buttons:

• Last Condition _ Display the previous condition specified for this dependency (i.e. move

from displaying Conditional M of N to displaying Conditional M-1 of N).

9TFA >= TWA

t°TWA <= 0

11NW < n

12(NI-TA) > n
t3NF > n

14NFP > n

lSNFT > n
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• Next Condition ---+ Display the next condition of this dependency (i.e. move from dis-

playing Conditional M of N to displaying Conditional M+I of N).

• Edit --* Menu for appending, copying or deleting conditions of this dependency.

For the example system, the "Kind" of dependency is specified as unconditional, because it is

always in effect regardless of the system configuration. If we were describing a dependency that

was only in effect when certain system conditions were true, we would select conditional, and a

menu would appear for describing the system conditions that must be true for this dependency

to be in effect. The dependency specification panel to show that removal of processor 3 causes

removal of memory 3 is shown in Figure 15.

.......... iJJ_........ .............. _2 ............................. L___JEl " .....................
_|_|i,,iiil!!_!_..!!=!_,_i_=,._.._::==_;_-iwi;z- ........... =.,,. =f;_,;_.:-:_-:;::_y:, :-%=;_ .. ......... .. .... J,....................................
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Figure 15: Specification of third dependency

Since the second dependency is similar to the first, we will use the Copy option of the Dependency

Edit menu to specify the second dependency. When the Dependency Specification panel appears,

it already has the information specified for the first dependency, and we have only to change
the two l's to 2's and select the "Okay" button to input this dependency. Similarly, the third

dependency can be input as a modification of the second.
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Kind:
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O Conditional
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Component Name: i processors J [' ]: I

O is failing O arrival of permanent _,_ _rrival of transient

is being removeo _ Is recovering ) is disappearing

Effect I of 1:

Comoonen,N=_,: I memories l l, ]: ["- J

failure 0 removal 0 disappearance

 ast .eotI l"ex' "eot,

Figure 16: Concise Specification using "=" to denote "same index"

Alternately, we could have input our example system with a single dependency using the "="

in the effect to denote "use the same index" as used in the cause. This is illustrated in Figure

16. Note that the index on the cause is left blank unless a specific index value is given. The

"=" is illegal in the cause as illustrated in Figure 17.

2O



Kind: Cause: Effect 1 of 1:
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Figure 17: Index of "=" Belongs only on Effect

3.4 System Failure Conditions

The conditions leading to system failure are defined in terms of functions of the states of the

components in the system, for example, majority vote failure of subsystem A or exhaustion of

parts in subsystem B. The menu interface presents a list of functions to choose from, or the user

may elect to input a textual description. The interface also allows the user to define system
failure conditions that are functions of several conditions; for example, a given system may fail

if both the primary memory fails a majority vote and the backup memory has failed. Using the

menu-driven interface, the user creates a list of independent conditions, any one of which will

cause system failure. In the table, each system failure condition in TOTAL is referred to as a

"DEATHIF" condition, named for the ASSIST statement of the same name.

For the example system, we will define three system failure conditions: majority vote failure of

processors, majority vote failure of memories, and majority vote failure of the bus components.

The three conditions are independent in the sense that system failure occurs if any one of the

three conditions holds. To describe the first condition, select the Append option from the Edit

menu beside the System Failure Conditions table, and the System Failure Description panel

will appear. Figure 18 shows the System Failure Description panel filled in with the correct

information to describe majority vote failure of the processor subsystem.

The System Failure Descriptions panel contains the following fields:

• Component Name _ Name of component type.

• [,] _ Which component of this type triggers this death specification. Default index is

"=" or blank (not applicable), which means that any component of this type can trigger

this death specification.

• If an index is given, then one or more of the following must be chosen to specify the

condition of the specified component that must be effect for this death specification to

occur:

- failed _ This death specification can only occur when the specified component has

failed (either permanent or transient) but is still in the active configuration (has not
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Figure 18: System Failure Description for Majority Vote Failure of Processors

been replaced by a working spare component or removed through degradation), is

- permanent fault _ This death specification can only occur when the specified com-

ponent has failed permanently but is still in the active configuration (has not been

replaced by a working spare component or removed through degradation). 1_

- transient fault _ This death specification can only occur when the specified com-

ponent is experiencing a transient fault and is still in the active configuration (has

not been replaced by a working spare component or removed through degradation), is

- removed ---* This death specification can only occur when the specified component

has been removed from the active configuration through degradation. 19

• If an index is not given, then one of the following must be chosen to specify the condition

of the specified component that must be effect for this death specification to occur:

- majority vote failure _ This death specification can occur only when a majority of

the active parts in the component have failed. _°

- exhaustion of parts _ This death specification can occur only when all of the parts

in the component have failed. _

X¢FA[ix]

_TFP[ix]

tSFT[ix]

_gNOT A[ix]
_°TFA >= TWA

_TWA <-- 0
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- # working < n --_ This death specification can occur only when the number of

working parts in the component is less than "n'.22

- # removed > n --_ This death specification can occur only when the number of parts

removed from the component is greater than "n'. The number of parts removed from

a component is defined to be the difference between the number initially and the total

active which remain in the configuration. 23

- # failed > n ---* This death specification can occur only when the number of failed

parts still active for the component is greater than "n" ?4

- # permanent failed > n --* This death specification can occur only when the number

of permanent failed parts still active for the component is greater than "n".2s

- # transient failed > n _ This death specification can occur only when the number

of transient failed parts still active for the component is greater than "n". 26

- textual ----* This death specification can occur only when the textual ASSIST syntax

Boolean expression holds true. The syntax of the expression is not checked for validity,

however, TOTAL does enforce balancing of parentheses within the expression.

• n _ If one of the above bullets which reference a value for "n" is selected, then the value

to be used for "n" must be entered here.

• negate this one -----* Causes the negation of this condition to be used, e.g. changes "#

working < n" to "not(# working < n)."

• negate whole DEATHIF _ Causes the negation of the entire IF. (e.g., "not ((# working

< n) and (transient fault))").

Each panel holds one condition description. The user may conjunctively link together as many

conditions as he wishes to form a complex system failure specification. This is accomplished

using the Edit menu located on this panel. The user may view the multiple conditions that

make up a single complex specification by using the "Last Death" and "Next Death" buttons

to move through the specification. Note--Individual DEATHIFs are "OR'd" together and are

specified using the Edit menu on the System Description panel. The multiple conditions within

a single DEATHIF are "And'd" together and are specified using the Edit menu located on the

Deathif Specification panel.

To specify that majority vote failure of the processors is assumed to cause system failure, specify

processors for the component name, select majority vote failure, and select the "Okay" button.

System failures due to memories or buses failing majority votes are specified in a similar manner

using either the Append or the Modify option of the Edit menu on the System Description

panel.

The complete system description is shown in Figure 19.

22NW < n

2a(NI-TA) > n
_4NF > n
25NFP > n

_6NFT > n
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s0..P00,.: II

Comp processors
memor les
bus

0

;rans/int _egrad dedicated-spares pools:

trans 3-2-I I 6.113e-4 Full

trans 3-2-I 0
non 0

Dependencies:
condition: cause -> effect

REM(processors[l]) -> REM(memorles[1])

REM(processors[2]) -> REM(memories[2])

REM(processors[3]) -> REM(memorles[3])

System Failure

Conditions:
DEATHIF MAJ(processors)
DEATHIF MAJ(memorles)

}EATHIF MAT(bus)

Figure 19: A sample system modeled with TOTAL
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3.5 Display of System Definitions

The user can elect to see the System Definitions that will be written to the ASSIST output

file in an additional panel, which appears at the bottom of the screen so as not to obscure the

System Definitions panel. To bring up the additional panel, select the option to "Show System

Definitions" from the "Opt's" options menu, as shown in Figure 20.

_lnm sit* fill ........ prvb-of-det eet Son [UJ_r_

[] __¢_.-_-_ _ .......
_tamb redtmd rlms/int degrM I dedtcated-spar Sltew_qdmn DllbIRlenl
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p_e_::rs t .... 3=2-|trlnl 3=2-1 0

il i
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[]

ItA_4 Z t tgta (pro_eeeorl)
irAt14_ ! ?J_] ( lll¢lor t el )

OlaY14r r t41ba(hue)

[]

II

n

Figure 20: Using pull-down menu to show system definitions

After the panel appears on the screen, the screen will appear as shown in Figure 21.

3.5.1 Adding auxiliary state-space variables

The user can define additional state-space variables and can change their values as effects of

dcpendencies. User-defined state-space variables can be used in system failure conditions or in

triggers or conditions of dependencies. To add user-defined state-space variables, the Edit menu

on the System Definitions panel is used.

Figure 22 shows how the user would enter an additional state-space variable named "test", which

is an array of Boolean' s. The optional identifier applies when there is either an array range or

a range of values or both. It does not apply for Boolean scalars (non-arrays) selected. If the

array were, for example, to contain an array of 1..24, then the user could specify a name for

the upper bound of 24. The initial value is used in the corresponding START statement in the

generated ASSIST output file.

3.6 Writing Comments and/or Remarks to describe a system

The user may describe a system by selecting the option "System Description Comments and/or

Remarks" from the "Opt's" options menu, as shown in Figure 23. Some sample remark input
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?oolname size failure-rate pr_b-of-det eat ton

P0OlS:

J name redund tronslint _egrad dedicated-spares pools:

Components: -- trans 3-2-I I 6.113e-4 Full_

processors

memories trans 3-2-I 0

bus non 0

System Failure

Conditions:
DEATHIF MAJ(processors)

DEATHIF MAJ(memories)
DEATHIF MAJ(bu$)

Space Constants:

Prune After - 4; (* Prune aft,

Nl_processors- 3; (* Redundant
NSl_processors- I; (* Dedicated'
NI memories - 3; (* Redundan_

HI-bus - 4; (* Redundant

NTOT - NI processors + NSI_.procei

late Constants:

_rocessors- ].2e-4; (* Perma] 1

_roc®ssors- 3.552e3; (* Rate |

R S_processors- 3.552e3; (* Rate
L-T_.processors- Ae-4; (* Trans:|

DES_processors- 6.5e5; (* Rate

Figure 21: Workstation with both System Description and Definitions panels present
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Figure 22: Defining an extra state-space variable

is shown in Figure 24.

27



Figure 23: Usingpull-down menuto specifycommentsand/or remarks
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i aajorxty of the sentries and a _a3ority of the buses nust be vorking. Upon II
detection of _e first processor failure, the spare processor is brought into II
the configuration to replace the faulty processor Upon the second processor I I

failure, the faulty processor is removed and the tensing, tvo vork_ng _J

processors cont_uue in duplex node. Failure of one or r.,ne remaining two i
working processors is aeeused to i_atsdiately defeat the aa3ority voter, Each •
memory unit is attached to one of the p_ocessors and reaoval of a failed B

I I

Figure 24: Input of extra remarks/comments
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4 Generating and Solving the Reliability Model

Once the system description process is complete, the user can generate the ASSIST input de-

scription for his system and even execute the ASSIST and SURE computer programs directly

from the TOTAL menu-driven interface. Several model-reduction techniques, such as pruning

and trimming, are available through the TOTAL interface[6, 7].

4.1 Algorithm for Generating ASSIST-Language Description

As shown in the preceding section, the TOTAL menu-driven interface presents the user with a

set of choices for describing the characteristics of his systems. The TOTAL program generates

an ASSIST-level description of the system by executing a set of algorithms based on the system

description information. The ASSIST language description is made up of the following basic

elements: 1) a set of state-space variables, which are used to describe the states of the model; 2)

a description of the initial state of the model; 3) a set of transition-description statements that

define the legal transitions between states in the model; 4) a set of system failure conditions

for the model; and 5) a set of constants and variable definitions that are used in the transition-

description and system failure statements. The basic algorithm used by TOTAL for generating

an ASSIST-level description of the system is as follows.

First, the TOTAL program generates the state-space variables, constants, and variable defini-

tions needed to represent the behavior of the components in the system. As an example, the

"processors" subsystem of the example system described above is degradable and has a spare

that can fail, and both permanent and transient faults can be modeled. Thus, the ASSIST

description would need state-space variables to represent the number of working processors in

the active configuration, the number that have failed permanently, the number that have failed

due to a transient fault, and the number of working and failed dedicated spare processors. Sev-

eral constants would be defined for the "processors" components; for example, permanent and

transient failure and recovery rates.

The next step is to generate transition-description statements to represent the failure behavior

for each component in the system. Several transition-description statements are needed to

describe each of the component types in the system. For example, the "processors" components

can fail permanently or with a transient fault, the transient faults can disappear, failed processors

can be replaced with the dedicated spare, and once the dedicated spares are exhausted, the

subsystem recovers from failures by degradation. Each of these behaviors is captured in a

separate statement. The dependencies must also be included in these statements. For example,

the statement that represents removal of processor 1 must also remove memory i from the active

configuration.

Finally, the system failure conditions for the model are described in the ASSIST language. This

simple process consists of replacing each function in the TOTAL description with its underlying

formula in ASSIST. For example, the majority vote function name used in TOTAL is replaced

with a formula checking whether the number of working processors in the active configuration

is greater than the number of failed processors in the active configuration.
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As shownin the abovedescription, the processof generatingthe ASSIST descriptiondepends
on a set of algorithms for converting the information from the systemdescription tables into
an appropriate ASSIST representation. The correctnessof this processlies in the generality
of the individual algorithms. In other words, the algorithm for generatingASSIST transition-
descriptionstatementsto reflect replacinga failed componentwith a sparemust work correctly
for all possiblecombinationsof characteristicsthat areallowedin the TOTAL systemdescription.
It must take into accountall possiblecombinationsof dedicatedand pooledspares,sparefailure
rates and detectability, and all possibledependenciesthat might be involved. This can be
especiallydifficult in the presenceof conditionaldependencies.

The approachadopted for the developmentof TOTAL has been to start with a limited set
of choicesand to carefully analyzethe generality of each added feature and its accompanying

algorithms. By doing so, we hope to preserve the correctness of the model generation process.

We also plan to document the algorithms used so that the user will know exactly what assump-

tions are in the model and so that the algorithms can be independently checked for accuracy

and generalism. Of course, any computer program will contain bugs, so users are cautioned

to check the ASSIST model description for reasonableness and accuracy. Also, analysis of the

generality of algorithms will grow increasingly difficult as the complexity of the system descrip-

tion choices grows. The example used in this paper was relatively simple, yet the ASSIST file

generated by TOTAL was 692 lines long, including comments. As the number of components

and the complexity of failure behaviors grows, reliability model descriptions tend to increase

combinatorially.

The TOTAL program is significantly limited in terms of the characteristics of systems it can

model accurately; however, the user will know when he has reached those limitations because

the menu interface will not include those characteristics.

4.2 Naming Conventions Used During Generation

When TOTAL generates an ASSIST input model file, it generates names with a prefix and a

suffix. The prefix always ends with an underscore character(" 2'). The suffix is always the name

of the component or spare pool in question.

The prefixes used are shown in Tables 1 and 2. Only those prefixes that are applicable to

the component type are defined; however, they are defined whether or not they are referenced.

For example, if transients are not being modeled, then none of the prefixes that apply only to

transients will appear. If, however, transients are modeled, then all of the prefixes that apply to

transients will be defined regardless of whether or not they are referenced. This is because the

user may wish to reference them directly by name in textual DEATHIF and textual dependency

condition tests.

Some of the other variables and/or constants that are defined are listed in Table 3;
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prefix meaning
NI_ The numberof parts initially active in a given component.
NSI_ The number of dedicatedsparesinitially active in a given component

or the numberof sparesinitially active in a givensparepool.
TSI_ The total numberof spares(both dedicatedandpooled) initially avail-

able for useby a given component.
TFA_ Count of Total FailedActive for a given component.
TWA_ Count of Total Working Active for a givencomponent.
NF_ Count of Number FailedActive for a given component.
FA_ FailedActive for eachpart of a givencomponent.
A_ Active for eachpart part of a givencomponent.

TA_ Count of total Active for a givenpart of a component.
TS_ Count of total numberof sparesavailablefor useby a givencomponent.

This includesboth dedicatedand pooled spares. Do not confuseNS_
and TS_for a component.

NA_ Count of the total numberactive in a component.
NW_ Count of the total numberactive and working in a component.
NFP_ Count of the total number active yet failed permanently in a

component.
NFT_ Count of the total numberactiveyet failed transiently in acomponent.

NWOT_ Count of the numberof activeworkingor failed transiently whichhave
not failed permanently.

WOT_ Indicates whether active and either working or failed transiently for
eachpart of a givencomponent.

NFS_ Count of the numberof failed hot or warm spareseither in a sparepool
or in the dedicatedsparesfor a component.

NWS_ Count of the numberof working hot or warm spareseither in a spare
pool or in the dedicatedsparesfor a component.

NFD_ Count of the number of failed hot or warm spareswhich have been
detected as having failed either in a spare pool or in the dedicated
sparesfor a component.

NFU_ Count of the numberof failed hot or warm spareswhich havenot been
detected as having failed either in a spare pool or in the dedicated
sparesfor a component.

Table 1: Table of prefixesusedin generatedASSIST file (Part I)
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prefix meaning
NUC_

TUC_

NS_

PRF_

PRW_

Count of the number of hot or warm spares which have not been de-

tected as having failed either in a spare pool or in the dedicated spares

for a component. This is effectively the number of spares under con-

sideration for the spare pool or the dedicated component spares in

question.
Count of the total number of spares including both dedicated and

spared which have not been detected as having failed for a compo-

nent. This is effectively the number of spares under consideration for

the component in question.

Count of the number of spares either in a spare pool or in the dedicated

spares for a component. Do not confuse NS_ and TS_ for a component.

Probability that a given spare has failed in either a spare pool or in the

dedicated spares for a component.

Probability that a given spare is still working in either a spare pool or

in the dedicated spares for a component.

Table 2: Table of prefixes used in generated ASSIST file (Part II)

identifier meaning

NCF

NCFMX

NTOT

Prune_After

TRASH_CAN_SIZE

The number of component failures

The maximum possible component failure count. This is used as the

upper bound of the range of values for NCF.

The total number of parts in the system including all components, all

dedicated spares, and all spare pools. This is used to make assertions

that all parts be accounted for. This does not include any auxiliary

state-space variables.

The number of component failures after which pruning should take

place

The number of parts which have been removed from the system, hence

the number of parts which have been discarded or "trashed". This is

used to make assertions that all parts be accounted for. This does not

include any auxiliary state-space variables.

Table 3: Table of miscellaneous identifiers used in generated ASSIST files
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4.3 Using the Menu-Driven Interface to Generate and Edit the

ASSIST-Language Description

To generate the ASSIST output file, select the option "Generate ASSIST" from the "File"

options menu. The ASSIST output file generated for our example system is shown in Appendix

D. After generating the ASSIST output file, the system editor can be used to view and perhaps

even edit the file before running it. To do this, select the option "Edit ASSIST" from the "File"

options menu. A new window will appear with the editor session as illustrated in Figure 25

taken from a VMS session.

i\'t .B,_

File Edit Formmt Search Display Customize Help

__OPTION WID=141; 0

(s*e****s¢**em_e*s***mess*****s*sw**wcs***st*I)

(,** *.,)

(*** TROLE ORI_NTEfl SYSTEM DESCRIPTION ***)

(*,* ,*,)

(s*e*eaeoeeeeeewo#eee_eeeoei**ao_el**¢ee*e**e*)

(t*esoee*eeeemeu*#eeemeee**eeoemsemiuese#e*_t*)

ellililillalllllillllllllillelOlililliilliliOOillalilllllllilllaUliOUilaillili

list oF 8pare poo18:

Doolneme e_ze flllure-rmto prob-of-detectLon
..............................................................

hot 3 1,2o-4 L_detectable

cold 12 nla Under•crab1•

O! P_

292 ILnes reed from file DISKSWRHOO:[OPB,S_RELIRB,S_TOTRL]$RNPLE.RST; I

Figure 25: Editing the Generated ASSIST Code Under VMS

TOTRL_GEN[RRT_:

COM_IEHT OFF;

Figure 26: Editing the Generated ASSIST Code Under UNIX

When the user is in the middle of an edit session, the TOTAL program will not allow the user
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Figure 27: Editing the GeneratedASSIST Codewith EMACS

to exit. Figure 28 shows the system reminding the user to first quit the editor session before

quitting the TOTAL session.

Figure 28: Cannot Quit When an Editor Session is Still Active

4.4 Setting Generation Options and Values

The options and values used when generating the ASSIST output file are specified by pulling

down the "Opt's" menu as shown in Figure 29.

The Set Generation Values/Options panel is shown in Figure 30 with the default values given

and in Figure 31 with the values used for the sample system. The panel contains the following

items:
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Figure 29: Using Pull-Down Menu to Set Generation Parameters

• Prune ARer Number of Component Failures: ---* Integer value representing the ASSIST

pruning level. The default is to assume system failure when 4 or more of the components

in the system have failed.

• List TOTAL tables in ASSIST comments? _ Include a printout of the TOTAL system

description tables in comments in the ASSIST-language file generated. The default is to
include this table.

* Generate Assertions? ---- Include meaningful assertion statements in the ASSIST file

to check correctness of the ASSIST description. The ASSIST assertions are described in

detail in the ASSIST User's Manual. Assertions can give the user insight into the meaning

of the ASSIST-language model descriptions, and may also be useful for uncovering possible

errors in the system description. The default is not to generate assertions.

• Track Removed Components? _ Create and update a variable (TRASH_CAN_SIZE) that

tracks the number of components removed from the active configuration. This variable

can be used in model pruning. The default is to track removed components.

• Additional Trace Comments? _ Provide additional comments in the ASSIST-language

description, such as noting the effects of dependencies on the TRANTO statements. The
default is to include these additional comments.

• Keep but comment out any dead transitions? _ This option, when selected, will com-

ment out any generated TRANT0 statements for which it can be determined that the source

state will always be a death state. Use of this option will reduce the number of AS-

SIST warnings when the model is run. The default is to keep but comment out any dead
transitions.
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Use explicit indicies when possible? _ This option uses a numerical value when possible

in generated TRANTO statements. For example, without explicit indicies, the generated

"IF (ix = 3) THEN . .. TRANTO ABCIix]" will, with explicit indicies, be generated as

"IF (ix = 3) THEN . .. TtLt,NTO ABC[3]". The default is to use explicit indicies when

possible.

Count Spare Failures for pruning? _ Include spare failures when counting the number

of components removed from the configuration for pruning. The default is to count spare

failures for pruning.

With trimming turned on? _ Set TRIM=ON in the ASSIST-language file and calculate

an appropriate TRIMOMEGA constant for ASSIST trimming. The default is to trim the

model.

Comment Conflicting Dependency Effects _ When generating an ASSIST model, con-

flicting dependency effects, such as one or more dependencies causing both the increment-

ing and decrementing of the same variable, generate warning messages and are otherwise

ignored. Although it is often desirable to ignore these, they can sometimes indicate an

erroneously modeled file. If this option is selected, then a comment will be placed in the

generated ASSIST input file in the destination of the TRANTO where the ignored effect

would have gone had it not been ignored. The default is not to comment conflicting effects.

Comment Duplicate Dependency Effects ----* When generating an ASSIST model, du-

plicated dependency effects, such as one or more dependencies causing the same effect

specified more than once, are ignored. Although it is desirable to ignore these, they can

sometimes indicate an erroneously modeled file. If this option is selected, then a comment

will be placed in the generated ASSIST input file in the destination of the TRANTO where

the ignored effect would have gone had it not been ignored. The default is not to comment

duplicate effects.

With "COMMENT OFF;"? ----* Include the statement "COMMENT OFF;" in the AS-

SIST model description, which will cause ASSIST to generate the SURE model without

the state-space variable values in comments. Inclusion of SURE-level comments is usually

not desired because it significantly increases the size of the SURE model file. The default

is to turn "COMMENT OFF;".

SURE pruning _ This option determines how much SURE level pruning[2] is performed.

With the choice "PRUNE = 1.0E-N", the value of "n" specified sets the prune level to 10 -".

The default is "AUTOPRUNE".

The user can select any combination of options from the panel.

The user unfamiliar with ASSIST model pruning and trimming is directed to [7] or [8] for a

description of those techniques. The SURE program cannot solve models with competing transi-

tions specified as means and standard deviations unless the probability of each path traversal is

also given. Trimming fortunately has the effect of eliminating these competing transitions from

the model. It is assumed that many models will require trimming, so trimming is turned on as
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Figure 30: Default Options Used to Generate ASSIST Output File
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• List TOTAL tables In ASSIST comn_nts?

• _ Assertions?

• Trick Removed Components?

• Additional Trace Comments?
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• co=_ spe_, Fldlum$ for pruning?
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I-I Comment Conlgcting Dependency Effects

f't Comment Duplicate Dependency Effects

• With "COMMENT OFF;'?

SURE pruning:

• None <> AUTOPRUNE <> PRUNE- 1,0E -N _

Figure 31: Changing Options Used to Generate ASSIST Output File
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the default. TOTAL automatically determines a suitable, conservative value for the trimming

input parameter, TRIMOMEGA, so the trimming is done automatically. For the few models

that have all FAST recoveries, the user can turn trimming off if he wishes to do so. If the user

turns TRIM 0FF and this is not appropriate, then the system will warn the user, as illustrated

in Figure 32. The user can choose to ignore the warning, but the model will not be solvable as

is.

Figure 32: Warning for Systems for Which TRIM Should Remain On

If the user were to enter a system that had all FAST rates, turn trimming off, and then make

a change to the rates that would require trimming in order to solve the modified model, the

warning will appear again as illustrated in Figure 33. The user will be warned when a rate is

changed from a safe rate to an unsafe rate and also when the "Okay" button is clicked.

Non-exponential rates are also disallowed when a component models transients as illustrated in

Figure 34.
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Figure 33: Warning Also Appears When Rates Are Changed
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Figure 34: Warning Also Appears with non-exponential Rates when Transients are Modelled
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5 Model Generation Logic and Mathematics

When defining a component, two types of recoveries can be specified. These are:

• recovery by swapping in a spare

• recovery by degrading the system

In either case, the faulty component is removed from the active configuration.

To specify the availability of spares, input a "Dedicated Spare Count" greater than zero and/or

enter the name of at least the "Primary Spare Pool" on the "Component Configuration" panel

as detailed in Section 3.2 on page 10.

To specify that a component will degrade, click on one of the radio buttons in the "Degradable"

box on the "Component Configuration" panel as shown in Figure 10 on page 10.

5.1 Spare Component Logic and Mathematics

Whenever a component has available spares (either dedicated or pooled), then a faulty processor

is removed and replaced with a spare. If there are dedicated spares, they will be used first. If

there are spares available in the primary spare pool, they will be used first after all dedicated

spares have been used. The secondary spares are used next, followed by the tertiary spares.

In the case of hot or warm spares, which can fail before ever being used, the spares always

fail permanently. This is significant when transient faults are present. In the presence of

a failed transient, replacement with a failed spare is modeled by removing the failed spare

from the available spares, removing the failed transient, and adding a failed permanent to the

configuration. In the presence of a failed permanent, this involves only removing the failed spare

since the net effect of the replacement is to swap one failed permanent for another.

The generated transitions to replace a failed transient with a failed spare are:

NFS_ component--, NFT_component--, NFP_component ÷+,

or

NFS_spare--, NFT_component--, NFP_component ++,

whereas the generated transition to replace a failed permanent with a failed spare is:

NFS_component--,

or

NFS_spare--,

where "component" is the name of any component that has a transient fault and "spare" is the

name of any spare pool from which the component may draw spares. The "NFS_component" is
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used for the number of failed dedicated spares in the component and the "NFS_spare" for the

number of failed spares in the spare pool named "spare".

When spares can fail, two transitions are generated instead of one; one for replacement with a

working spare and one for replacement with a failed spare. The recovery rates are adjusted by

the probability that the spare is working or failed, respectively. The probabilities are computed

as:

IMPLICIT PRF_spare[NWS_spare,NFS_spare] = NFS_spare / NUC_spare;
IMPLICIT PRW_spare[NWS_spare,NFS_spare] NWS_spare / NUC_spare;

where "NUC_spare" is the number of spares under consideration and is defined to be the total

count of all spares that have not been detected as having failed.

In the case of partially detectable spares, these probabilities are computed as:

IMPLICIT PRF_spare[NWS_spare,NFD_spare,NFU_spare] = NFU_spare I NUC_spare;

IMPLICIT PRW_spare[NWS_spare,NFD_spare,NFU_spare] NWS_spare / NUC_spare;

Where "NFU" stands for the "number of failed undetected" spares and "NFD" stands for the

"number of failed detected" spares.

In the case where the probability of detecting a failed spare is 100%, the system will not generate

a transition for swapping in a failed spare.

5.2 System Degradation Logic and Mathematics

Whenever the user defines a component as degradable by selecting some "Degradable" option

other than "Non-degradable" from the "Component Configuration" panel, rules are generated to

the ASSIST model output file in order to degrade the system according to the option specified.

There are three options other than the "Non-degradable" option, namely:

• Triplex to duplex to simplex

• Triplex to simplex

• Duplex to zero

5.2.1 Degrade "Triplex to duplex to simplex"

This is a simple case of degradation, which requires no additional logic since every degradable

component will always degrade by one until the system degrades to a triplex. This simple

degrade-by-one logic is placed in the ELSE clause of the generated IF when one of the other two

degradation schemes is selected as detailed in Sections 5.2.2-5.2.3.
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5.2.2 Degrade "Triplex to simplex"

In the case where system degradation is from three components to one component, the generated

transitions depend upon the current state of the component at the time at which the recovery

by degradation occurs. The cases without and with transients will be considered separately. Be-

cause degradation is from three active to one active, degradation by removal of two components

takes place only if the number active in the component in question is exactly three.

No transients occur for component

Whenever there are no transients for the component in question, the state space will be modeled

as active and working.

When modeled collectively, the space will be (N,t,,NW). Because there is a fault present that has

been detected, hence the need to degrade, there are only three possibilities for the current state

space configuration:

(NA,NW) = (3,2)

(NA,NW) = (3,1)
(NA,NW) = (3,0)

(i.e, two working, one faulty active)
(i.o, one working, two faulty active)
(i.e, all three are faulty active)

Case where two are working

In the case where there are two working, since there are three active and one fault has been

detected, the system must necessarily remove one of the two working with the failed one when

it degrades from three to one. This happens 100% of the time:

(3,2) --_ (1,1) ]A=IA-2,NW-- 100_ of the time (throe away one of the working ones)

When modeled individually, for each of the cases, a loop and if test will be generated in order

to figure out which are the two working. In this case, there is a 50% probability of pulling the

first working one and 50% probability of pulling the other working one.

Case where one is working

In the case where there is only one working, the system will remove the detected failed and one

other processor. The other one removed could be the other failed one or it could be the working

one. There is a 50% probability in either case. The transitions will be:

(3,1) ---. (1,0)
(3,1) ---. (1,1)

NA:NA-2,NW--
HA:HA-2

50X of the time (throe away the eorking one)
50X of the time (throe aeay the other failed one)

When modeled individually, for each of the cases, a loop and if test will be generated in order

to figure out which of the other two is the working one and which is the failed one.

Case where all have failed
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In the case where there are no working, the system will merely remove two faulty with 100%

probability:

(3,2) ----*(I,I) _AfNA-2 I00_ of the time (throw away one of the other two faulty ones)

When modeled individually, for each of the cases, a loop and if test will be generated in order

to figure out which are the other two faulty. In this case, there is a 50% probability of pulling

the first one of the other two faulty and a 50% probability of pulling the last one of the other

two faulty.

Transients occur for component

Whenever there are transients for the component in question, the state space will be modeled

as working, failed permanent, and failed transient.

When modeled collectively, the space will be (NW,NFP,NFT). Because there is one fault present

that has been detected, hence the need to degrade, the number working can be no more than

two. There are many possibilities for the current state space configuration:

NW = 2

(NW,NFP,NFT) ffi (2,1,0)
(NW,NFP,NFT) ffi (2,0,1)

NW = 1
(NW,NFP,NFT) ffi (1,2,0)
(NW,NFP,NFT) ffi (1,0,2)
(NW,NFP,NFT) ffi (1,1,1)

NW = 0

(NW,NFP,NFT) = (0,3,0)
(NW,NFP,NFT) ffi (0,0,3)
(NW,NFP,NFT) ffi (0,2,1)
(NW,NFP,NFT) ffi (0,1,2)

Case where two are working

In the case where two are working, the system will remove the detected failed and one of the

two working. In either case, there is a 100% probability of removing one of the working ones.

The transitions will be:

If the failed one is a permanent:

(2,1,0) -- (1,0,0) IOOZ _W--,WFP--
If the failed one is a transient:

(2,0,1) _ (I,0,0) IOOZ NW--,NI='*I '--

(throe away one working)

(throe away one working)

When modeled individually, for each of the cases, a loop and if test will be generated in order

to figure out which are the two working. In this case, there is a 50% probability of pulling the

first one of the two working and a 50% probability of pulling the last one of the two working.

Case where one is working
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In the case where only one is working, the system will remove the detected failed and one of the

other two. One of the other two that could be removed is the working one; however, the other

one that could be removed might be either failed transient or failed permanent.

If both are failed permanents, then the system could throw away a working with the detected

failed permanent or it could throw away the other failed permanent with the detected failed

permanent. Each possibility would happen with 50% probability.

If both are failed transients, then the system could throw away a working with the detected failed

transient or it could throw away the other failed transient with the detected failed transient.

Each possibility would happen with 50% probability.

If there is one each of failed transient and failed permanent, then the detected failed could

be the failed permanent or it could be the failed transient. There is a 50% chance of either

case. When the detected one is a failed permanent, then there is a conditional 50% chance of

removing the working and a conditional 50% chance of removing the failed transient with the

failed permanent. When the detected one is a failed transient, then there is a conditional 50%

chance of removing the working and a conditional 50% chance of removing the failed permanent

with the failed transient. The unconditional probabilities multiply to 25% with the case of

removing both a failed permanent and a failed transient occurring twice to make 50%.

The transitions will be:

If both failed are perms.nents:

(1,2,0) _ (0,1,0) 50_ NW--,NFP-- (throw away the working)
(1,2,0) _ (1,0,0) 50_ NFP=NFP-2 (throw away other failed)

If both failed are transients:

(1,0,2) _ (0,0,I) 50_ NW--,NFT-- (thro. away the working)
(1,0,2) _ (I,0,0) 50_ NFT=NFT-2 (throw away other failed)

If one of the two failed is permanent and the other transient:

(1,1,1) _ (0.1,0) 25_ NW--,NFT-- (throw away working)
(I,I,I) _ (I,0,0) 50_ NFP--,NFT-- (thro. away other failed)

(1,1,1) ---_ (0,0,1) 25_ NW--,NFP-- (throw away working)

When modeled individually, for each of the cases, a loop and if test will be generated in order

to figure out which is the other failed and which is the working.

Case where all are failed

In the case where all have failed, the system will remove the detected failed and one of the other
two failed.

If all three have failed permanently, then the detected fault must be a permanent fault and

another failed permanent will be thrown out with it. The probability is 100%.

If all three have failed transiently, then the detected fault must be a transient fault and another

failed transient will be thrown out with it. The probability is 100%.

If two of the failed have failed permanently, then the other will have failed transiently. If the fault

detected is a permanent, which will happen two thirds of the time, then the other fault could

be the other failed permanent or it could be the failed transient. The conditional probabilities

are 50% each. If the fault detected is a transient, which will happen one third of the time,

45



then the other fault could be the other failed transient or it could be the failed permanent.
The conditional probabilities are 50%each. Multiplying the probabilities, the result is a 67%
probability of removingoneof the two permanentswith the only transient and a 33%probability
of removingboth of the permanents.

If two of the failed havefailed permanently,then the other will havefailed permanently. If the
fault detectedis a transient, whichwill happentwo thirds of the time, then the other fault could
be the other failed transient or it could be the failed permanent. The conditional probabilities
are 50% each. If the fault detectedis a permanent,which will happen one third of the time,
then the other fault could be the other failed permanent or it could be the failed transient.
The conditional probabilities are 50% each. Multiplying the probabilities, the result is a 67%
probability of removingoneof the two transientswith theonly permanentanda 33%probability
of removingboth of the transients.

The transitions will be:

If all three have failed permanently: i

(0,3,0) ---_ (0,1,0) 100Z NFP=NFP-2 (throw away another permanent)
If all three have failed transiently:

(0,0,3) _ (0,0,I) 100_ IFT=NFT-2 (thro. a.ay another transient)

If t.o have failed permanently:
(0,2,1) ---* (0,1,0) 67_ NFP--,NFT-- (throw away perm and trans)

(0,2,1) ---* (0,0,i) 33_ NFP=NFP-2 (thro. a.ay both permanents)

If two have failed transiently:

(0,I,2) -- (0,0,I) 67_ NFP--,NFT-- (thro. a.ay perm and trans)

(0,1,2) _ (0,1,0) 33_ NFT=NFT-2 (thro. a.ay both transients)

When modeled individually, for each of the cases, a loop and if test will be generated in order to

figure out which are the failed transients and which are the failed permanents. When all three

have failed permanently, then the detected one is failed permanent and there is a 50% chance

of removing the first of the other two failed permanents and a 50% chance of removing the last

of the other two permanents. When all three have failed transiently, then the detected one is

failed transient and there is a 50% chance of removing the first of the other two failed transients

and a 50% chance of removing the last of the other two transients.

5.2.3 Degrade "Duplex to zero" (Self-Checking Pairs)

In the case where system degradation is from two components to no components, the number

active, number working, number failed permanent (in the case of transients), and number failed

transient (in the case of transients) are all set to zero.

When the component is modeled individually, each active, working, failed permanent (in the

case of transients), and failed transient (in the case of transients) is set to FALSE.

The rate used for this single transition is the normal recovery rate for degradation, namely

"R_.D_comp" for component "comp".

Because degradation is from two active to no active, degradation by removal of two components

takes place only if the number active in the component in question is exactly two.
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5.3 Recoveries and Death States

In many systems, many of the cases allowed for during the spare replacement and degradation

recoveries can never happen because the states are death states. The cases must be considered,

however, because this depends upon which system failure conditions were specified. For some

of the more common system failure conditions, TOTAL is able to determine that the current

state is a death state and the transitions are automatically commented out of the generated

ASSIST file so as to decrease the number of warnings such as:

[WARNING] NO TRANSITIONS GENERATED USING TRANTO ON LINE : nnn

However, users employing textual DEATHIF descriptions or complex combinations of system

failure conditions may see this warning when ASSIST executes. The warning can be safely

ignored.
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6 System Requirements

The TOTAL prototype program was written using the Transportable Applications Environment

(TAE) developed at NASA Goddard Space Flight Center in Maryland. The TAE system

executes on top of the Motif windowing system. The Motif system, which is based on X-

Windows, is available on quite a few different systems, including both SUN and VAX systems.

The TAE package was used in order to be portable between different systems and in order to

save development time.

6.1 Hardware/Operating System Requirements

6.1.1 Requirements to run pre-compiled versions

Executable files compiled at version 4.1.2 of SUN OS on the SUN SPARCSTATION 2r archi-

tecture are available for sites without compilers or TAE. To run the pre-compiled SUN OS

version, some version of the X (MIT or OpenWindows 3.0) must be executing. The Motif (mwm)

window manager must also be executing.

The TOTAL program has been ported to the VAX. Executable files compiled at VAX VMS

V5.5 are available for VAX sites without compilers or TAE. Executables are built with version

V3.1-051 of the VAX C compiler and with V3.8-273 of the VAX PASCAL compiler. To run

the pre-compiled VAX VMS, the DECwINDOWS MOTIF window manager must be executing.

6.1.2 Requirements to re-compile

The TOTAL program was written in ANSI-standard "C" by David Boerschlein. It currently

compiles on a SUN SPARCSTATION with the TAE V5.2 libraries executing the MOTIF win-

dowing system or on a VAX with the TAE V5.2 libraries under the VMS operating system

executing DECWINDOWS MOTIF.

An ANSI-standard "C" compiler is available from the Free Software Foundation ("gcc"). The

"C" compiler that is available with the VAX VMS operating system is also ANSI. The current

SUN "C" compiler will not compile TOTAL. SUN may release an ANSI "C" compiler in the

future.

Some of the programs (such as SURE, STEM, and PAWS) that are used to process ASSIST

output files require a Pascal compiler in order to re-build. The VMS version of TOTAL also

requires the Pascal compiler.

2ra trademark of SPARC International
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6.2 Memory Requirements

The TOTAL program will not execute on a system with less than 16MB of memory, and 24MB

is recommended for efficiency. This is because TOTAL makes use of a lot of windows. Both

MOTIF and DECWlNDOWS MOTIF use a good deal of memory.

6.3 Software System Requirements

The user must be executing under either the DECWINDOWS MOTIF or the MOTIF windowing

system on top of SUN OS.

Features of ASSIST referenced in TOTAL require ASSIST revision 7.1 or higher as well as

SURE, STEM, and/or PAWS revisions 7.9.8 or higher. Model files produced with TOTAL

can be processed with older revisions of SURE, STEM, and/or PAWS provided that the

combinatorial functions (COMB, PERM, FACT, and GAM) and the modulo operators (MOD, DIV, and

CYC) are not referenced. Use of dependencies that reference components of different redundancy

counts can generate ASSIST code that references the CYC operator. In this case, SURE version

7.9.3 is required.

6.4 Monochrome vs Color

The TOTAL program will run on either a monochrome or color terminal. Some of the features

of its look are more pronounced on a color terminal.
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7 Concluding Remarks

A prototype spreadsheet interface for a reliability analysis tool set has been described. The

TOTAL interface program allows the user to describe a system at a level of abstraction ap-

propriate for designers of fault-tolerant systems, even those with no background knowledge in

reliability analysis calculations. We do not plan to take this concept beyond the prototyping

stage; however, we believe that the interface method we have developed is powerful, and we

hope that other reliability analysis tool developers will gain new insights from our research and

perhaps develop a commercially available tool with the capabilities we envision.
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A Command Line Interface

For both UNIX and VMS systems, the TOTAL program is invoked via:

total

or

total <resource-file-name>

or

total <total-file-name>

or

total <total-file-name> <resource-file-name>

or

total <resource-file-name> <total-file-name>

Options can appear anywhere on the command line after the name of the command "total". They may precede

or they may follow the optional resource and/or TOTAL file names.

The user must specify a suffix of ".res" for the resource file name. The user may explicitly specify the suffix of
".tot" for the TOTAL file name but this is not required.

If more than one resource file name is specified, then the last one specified on the command line is used and the

prior ones are ignored.

If more than one TOTAL file name is specified, then the last one specified on the command line is used and the

prior ones are ignored.

A.1 Command Line Options File

The user may define an options file to override the default options. The options specified in the total options file

are parsed first before any command line options.

The name of the total options file on UNIX systems is:

•total_options

and its name on VMS systems is:

total_options, cfg

The file is located in the user's home directory.

Any and all of the command line options can be defaulted in the total options file.

No option in the total options file may span two lines and backslashes are not allowed. The user is free to put

more than one option on a line as long as the options are separated by whitespace. The user is also free to use

as many lines as desired.

A.2 Command Line Options

The TOTAL command line allows the user to specify options. These options control a number of parameters

and allow the user more control over how the TOTAL program executes.
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Options must be preceded by a slash under VMS as in:

/batch

and must be preceded by a dash under UNIX as in:

--batch

The following sample command lines are equivalent and specify the use of the "emacs" editor instead of "vi", use

of the "MyResource.res" resource file and initialization by reading in the existing (old) system called "sample":

total MyResource.res sample.tot --ema
total MyResource.res sample --ema
total sample MyResource.res -ema
total Myl:tesource.res --ema sample
total --ema MyResource.res sample

Options may be specified either in upper or lower case. The normal UNIX case sensitivity does not apply to

the TOTAL command line options.

The following options are available:

• -audio ----* This option tells TOTAL to play sounds when certain actions take place. This can be
useful, for example, with large models that take a fair amount of time to generate and solve. In order for

sounds to play, the operating system must have been installed with the demos option and the sounds files

must exist in "/usr/demo/SOUND/sounds". The default is not to play any sounds.

• -batch filename ----* Specifies that the program is to execute in batch mode instead of in workstation

mode. The typical user will not be interested in batch (".tba") files, however, many of the operations that

can be performed with the panels can also be done via special "commands" in a batch file. Batch files are

not fully supported. The default is interactive processing mode.

• -comp =ann ----. This option specifies the maximum number of components in the system. The default

is 100.

• -con =ann ----. This option specifies the maximum number of conditional dependency condition lllV list
items allowed in the system. This number is the cumulative total of the lengths of each condition AIiI_list

for each conditional dependency in the system. The default is 200.

• --dand =nnn -----, This option specifies the maximum number of system failure AliD list items allowed in

the system. This number is the cumulative total of the lengths of each DEATIIIF. The default is 200.

• --dep =ann ----. This option specifies the maximum number of dependencies allowed in the system. Each

dependency counts only once even though it may have several effects. The default is 50.

• --dif =ann _ This option specifies the maximum number of system failure conditions (DRITIIIF's)

allowed in the system. Each condition counts only once even though it may have several/,lid 's in the list.
The default is 50.

• -dl =nan ----* This option specifies the maximum number of dependency lines which a system is allowed
to have. Note that each effect increases the number of lines required by one. One dependency will therefore

require one line for each of its effects. The default is 180.

• -eft -ann _ This option specifies the maximum number of dependency effect list items allowed in the

system. This number is the cumulative total of the number of effects for each dependency in the system.
The default is 200.
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s --ema _ This option specifies that the EH,tCS editor is to be used when the user requests to edit the
ASSIST output file. This editor is available on both VMS and Unix systems as well as on many other

systems. One version of EHACS is available from the Free Software Foundation. The default is to use the

system editor and not to use r_,tcs. The Unix version of TOTAL assumes the version from the foundation

in that it uses the -nw option when invoking the editor.

• -eve ---* This option specifies that the VMS EVE editor is to be used when the user requests to edit the
ASSIST output file. If this option is specified and the user is running on a Unix system, then TOTAL

assumes that the user really meant to specify -vl and will use the Un£x vi editor instead. This ( -eve

) is the default on VMS systems.

• -nc =nan ----* This option specifies the maximum number of named constant lines allowed. Named

constants are not generated in TOTAL 1.0. The default is 100.

• -noaudio _ This option turns off the -audio option.

s -noeve _ This option turns off the -eve option.

• -novi _ This option turns off the -vi option.

• --pool =ann _ This option specifies the maximum number of shared spare pools in the system. The
default is 50.

• -prb =nan _ This option specifies the maximum length of the probability buffer. This buffer is used

to store the rate expressions for the TRANT0's before they are written to the ASSIST output file. The

default of 512 bytes should be much more than sufficient for virtually all system descriptions.

• -pro =nnn _ This option is the same as -prb .

• -rc =nan ----* This option specifies the maximum number of rate constant lines allowed. Rate constants

are generated for inclusion in the ASSIST output file and are displayed in the "System Definitions" panel.
Rate constants include means and standard deviations as well as fast and slow rates as specified for each

component, dedicated spare failure rates for each component, and pooled spare failure rates for each spare

pool. The rate constants also include the definition of TRIMOMEGA when trimming is turned on. The
definition of TRIMOMEGA takes many lines (one line per component fault arrival rate). The default is
800.

• -sc =nnn ----* This option specifies the maximum number of space constant lines allowed. Space constants

are constants that are required in the generated SPACE and START statements as displayed in the "System
Definitions" panel for inclusion into the ASSIST output file. These constants include the initial numbers

of components and spares. Also included is the grand total of all of the components used in the system.

The default is 300, which allows for approximately 150 initial numbers of components and spares.

• --sp =nan _ This option specifies the maximum number of space lines allowed for a generated SPACE
statement as displayed in the "System Definitions" panel. The default is 102, which corresponds to 100

state space variables plus a leading and trailing line.

• -ssv =ann ----. This option specifies the maximum number of auxiliary state-space variables that are

allowed in the system. The default is 50.

• -tto =nan ----. This option specifies the length of the transition buffer. This buffer is used to store the

TRANT0's before they are written to the ASSIST output file. When there is a big "domino effect" with

dependency causes and effects, the TRAliT0 can get rather large. The default is 4096, which corresponds

to about 50 lines in the ASSIST output file.

• -vi ---, This option specifies that the Unix vi editor is to be used when the user requests to edit the

ASSIST output file. If this option is specified and the user is running on a VRS system, then TOTAL

assumes that the user really meant to specify -eve and will use the VMS EVE editor instead. This ( -vi

) is the default on Unix systems.
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A.3 The Resource File

If the user has access to the Transportable Applications Environment (TAE) utility 2s, then the user can use the
TAE workbench to customize the resource file. This would be useful, for example, to change the colors used in

the displays. To do this, copy the resource file and run the workbench. For example:

cp /usr/local/bin/total_resource_flle.res myres.res

taewb -f myres.res 29

or

COPY RELIABILITY$DIR:TOTAL_RESOURCE_FILE.RES MYRES.RES
RUNWB MYRES.RES 3°

The TAE utility is not required to run TOTAL (just to re-build and link the executable and customize the

resource file).

A.4 Converting Between ASCII and TOTAL Description Files

Because TOTAL description files (".tot" files) are stored in system binary format, a description file cannot he
transferred to another system and used directly. For example, a total description file created on a SUN system

cannot be directly read on a VAX system.

In order to transfer TOTAL description files from one system to another, two commands are provided:

• tot2txt ----* Converts from binary ".tot" format to ASCII ".txt" format.

• txt2tot ----* Converts from ASCII ".txt" format to binary ".tot" format.

For example, to transfer a file named "myfile.tot" from the SUN to the VAX, do the following:

sunY. tot2txt myflle
sunY. $then copy the file "myflle.txt" to the vax$
vax$ txt2tot myflle

_SAvailable from COSMIC, # COS-10033 or COS-10034

29This corresponds to TAE V5.2 on SUN OS

a°This corresponds to TAE V4.1 on VMS
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B Installation of TOTAL

Installation of TOTAL is automated by the Makefile and or the VMSINSTAL procedure. There is a default

resource file that is accessed if one is not specified on the command line. This resource file must reside in the

system directories.

B.1 Under SUN OS

The default resource file must be accessed via the path:

/usr/local/bin/t ot al_resource_f ile. res

Each user can override this default by listing a resource file pathname in his/her own home-directory ".to-

tal_options" file.

B.2 Under VMS

On VMS, the default resource file must be accessed via the path:

RELIABILITYSDIR: TOTAL_RESOURCE_FILE. RES

Each user can override this default by listing a resource file pathname in his/her own home-directory "to-

tal_options.cfg" file.
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C Icons for TOTAL under Motif

The iconsforthepanelsinTOTAL areillustratedinFigure35.
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Figure 35: Icons that appear when TOTAL panels are minimized
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D Sample ASSIST file generated by TOTAL

The following is the ASSIST input file generated by TOTAL that corresponds to the sample system in this

manu&l:

C.OPTIO| TOTAL_GE|F_UTED;

C_OPTIO| WL=40;

C_OPTIO| WID=192;

C_OFrlO| WR£P_LO|O.CO|STMIT_EIPKS;

COMMEIT OFF;

( e i in i illllUlanlnnlnulnanaSllanaullnlnlalnnlnllUanlnnllnlnlUlH

This example system consists of a triplex sot of processors with one spars

processor, a triplex sot of msmor 7 units, and a quadruplox bus. All messages

and calculations performed in the system are subject to majority voting to

detect and mask failures. Thus, a majority of the processors in the current

configuratlon must be working, or system failure occurs. Similarily, a

majority of the memories and a majority of the buses must be working. Upon

detection of the first processor failure, the spars processor is brousht into

the configuration to replace the faulty processor. Upon the second processor

failure, the faulty processor is removed and the ramming two working

processors continua in duplex mode. Failure of one of the remaining ass

uorklng processors is assumed to Imodiatuly defeat the majority voter. Each

memory unit is attached to one of the processors and removal of a failed

processor alas results in removal of its attached memory. The memory unite

degrade from triplex to duplex to simplex as failed memory units are detected

in the conflguratlon or are removed because of processor removals. The bus

is non-roconfigurable.

|o spare pools defined.

list of components:

t name redund trans/int degrad dedlcated-spares

.................................................

1 processors 3 trams 3-2-1 1 6.113o-4 Fully

1 memories 3 trams 3-2-1 0

1 bus 4 non 0

pools:

........................

L_P R_D R_S L_T DIS

........................................

7.2e-4 3.552e3 3.552e3 ls-4 6.5e6

4.4s-3 12.213o3 n/a 5.403e-3 6.8e-4

2.202e-3 n/a n/a n/a n/a

list of dependencies:
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cause -> effect

RE,(processors[I]) -> REN(msmories[l_)

REN(processors[2]) -> REN(memories[2])

REN(processors[3]) -> REN(memorios[3])

Deathif list:

DEATH expression

.......................................................................

DEATHIF HAJ(proceseors)

DEATHIF NAJ(memoriss)

DKATHIF NAJ(bus)

go extra state-space variables defined.

||===||mm|ummn n u|mmn|nmmm = =m|nnmnlnmm|n|nn|mm= =m||nnuu|mm|mm|u =us )

(*** ***)

(see SPACE COISTAITS see)

(**e ***)

Prune_After = 4; (e Prune after 4'th component failure *)

|I_processors= 3; (e Redundancy count for "processors" *)

|SI_processors= I; (, Dedicated spare count for "processors" ,)

|I.memories = 3; (e Redundancy count for "memories" *)

lI_bue = 4; (e Redundancy count for "bus" *)

|TOT = SI_processors + |SI_processors ÷ El_memories + MI_bus;

(e total number of components initially *)

|CFMX = |TOT; (e Maximum possible component failure count *)

(*** ***)
(.** RATE COISTAITS **,)

(*** ***)

L_P_processors= 7.2e-4; (e Permanent fault arrival rate for "processors" e)

R_D_procossors= 3 552e3; (* Rate to degrade for "processors" *)

R_S_processors= 3.852e3; (e Rate to reconfigurs spare into "processors" e)

L_T_processors= le-4; (e Transient fault arrival rate for "processors" e)

DiS_processors= 6.5e5; (* Rate at ghich "processors" transient disappears *)

L_P_memories = 4.4e-3; (* Permanent fault arrival rate for "memories" *)

R_D_memories = 12.213e3; (e Rate to degrade for "memories" e)

L_T_memories = 5.403e-3; (e Transient fault arrival rate for "memories" *)

DiS_memories = 6.8e-4; (* Rate at shich "memories" transient disappears *)

L_P_bus = 2.202s-3; (* Permanent fault arrival rats for "bus" e)

TRINONEOA = |I_processors*L_P_processors +

|I_processorseL_T_procossors +

|I_memories*L_P_memories +

II_memorieseL_T_memories +

Rl_buseL_P_bue;

TRIN 0|;

AUTOPRU|E = O;

PRU|E = O;
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L_S.processors= 6.113s-4; (* Dedicated "processors" spare fail rate ,)

SPACE •

(

(W_processors :

(FP_processors:

(FT_proceeeors:

|We_processors

|FS_procsssors

(W_memories :

(FP_memorios :

(FT_msmories :

IW_hus

TRASH_CAB_SIZE

|CF

);

IMPLICIT

IMPLICIT

IMPLICIT

IMPLICIT

IMPLICIT

IMPLICIT

IMPLICIT

IMPLICIT

IMPLICIT

IMPLICIT

IMPLICIT

IMPLICIT

AKR3tY[1..gI.processore] OF BOOLEA|),

(* Each sorking in "processors" *)

ARRAY[1..|I_proceeeors] OF BOOLEA|),

(* Each permanent failed in "processors" *)

AkRAY[1..|I_processors] OF BOOLKA|),

(* Each transient faulty in "processors" *)

: O..|SI.proceseore,

(* dedicated gorking spares count, "processors" *)

: O..|SI_processore,

(* dedicated Failed spares count, "processors" *)

ARRAY[1..|I_memoriee] OF BOOLEAM),

(* Each uorkin s in "memories" *)

ARRAY[1..|l_nemoriee] OF BOOLEAM),

(* Each permanent failed in "memories" e)

AKKAY[1..|I_memories] OF BOOLEA|),

(* Each transient faulty in "memories" *)

O..EI_bus, (* Count of working in "bus" *)

: O.,|TOT, (e removed components *)

O..|CFMI (e lumber of component failures for PRUIJEIF $)

Jg_proceesore[M_processors] = COUNT(g_processors);

|FP_procsssors[FP_proceseors] = COUNT(FP_procsseors);

RFT_processore[FT_procsssors] = COUNT(FT_processors);

IWOT_processors[9_processore,FT_procsssors] =

(* |umber Working or Transient "processors" *)

lW_processors + |FT_processors;

gOT_processors[g.processors,FT_procneors](E) =

(* Working or Transient each "processors" *)

W_processors[E] OE FT.processors[E];

TFA_procsssors[FP_proceanore,FT_processors] =

(* Total active failed in "processors" *)

|FP_proceeeore + |FT_processors;

MF.proceesors[FP_processors,FT.processore] •

(e Total active failed in "processors" e)

|PP_proceseors + EFT_processors;

TgA_procsssors[g_proceseors] =

(* Total active vorkin 8 in "processors" ,)

gg_proceeeors;

TA_proceseors[g_processore,FP_processors,FT-procsssors] =

(* Total active in "processors" e)

TFA_processor8 + TWA_processors;

FA_procoesore[FP.processore,FT_processore](E) =

(* Active failed each "processors" e)

FP_procsssors[E] OE FT_processors[[];

A_proceanors[g_processors,FP_proceseors,FT-proceseors](Z) =

(* Test if active in "processors" *)

U_processors[E] OR FP_procossors[K] OR FT.processors[E];

lg_memoriee[g.memories] = COUlT(W.menories);
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IMPLICIT |FP_memoriee[FP_memories] = COUWT(FP_memories) ;

IMPLICIT gFT_memoriee[FT_memories] n COUHT(FT_memories) ;

IMPLICIT

IMPLICIT

IMPLICIT

IMPLICIT

IMPLICIT

IMPLICIT

IMPLICIT

IMPLICIT

EVOT_menories[W_msmories,FT_menories] =

(* Mumber Working or Transient "memories" ,)

|W_memories + EFT_memories;

WOT_memoriesEW_memories,FT_memories](E) =

(* Workin K or Transient each "memories" *)

W_memories[K] OR FT_memoriee[K];

TFA_memories[FP_memories,FT_memoriee] =

(e Total active failed in "memories" *)

WFP_memories + |FT_memoriss;

JF_memories[FP_memories,FT_memories] =

(e Total active failed in "memories" *)

IFP_memories + |FT_memories;

TeA_memories[W_memories] = (* Total active sorking in "memories" *)

WW_memories;

TA_memories[W_memories,FP_memories,FT_menoriee] =

(e Total active in "memories" e)

TFA_memories + TWA_memories;

FA_memories[FP_memories,FT_memories](E) =

(* Active failed each "memories" *)

FP_memories[Z] OSier_memories[El;

a_memories[W_msmories,FP.memories,FT_memories] (E) •

(e Test if active in "memories" e)

W_memories[X] OR FP_memories[K] OR FT_memories[E];

IMPLICIT

IMPLICIT

IMPLICIT

IMPLICIT

TFA_bus[|W_bus] = (* Total active failed in "bus" *)

MI_bus - IV_bus;

|F_bus[|W_bus] = (* Total active failed in "bus" *)

SI_bus - SW_bus;

TWA_bus[|V_bus] = (* Total active working in "bus" *)

|W_bus;

TA_bus[lW_bus] = (* Total active in "bus" e)

|I_bus;

IMPLICIT

IMPLICIT

IMPLICIT

IMPLICIT

IMPLICIT

IMPLICIT

|S_processors[JWS_processors,JFS_processors] =

DeS_processors + SFS_processors;

|UC_processors[l_S_processors,BFS_processors] =

|WS_processors;

PRF_processors[HWS_processors,|FS.procossore] =

WFS_processors / |UC_processors;

PRW_processors[J_S_processors,SFS_proceseore] =

|WS_processors / |UC_proceeeors;

TS_proceseore[SWS_proceeeors,|FS_proceseore] =

(* Total spares available to "processors" *)

|WS_proceseors + |FS_processors;

TUC_processors[|WS_processore,|FS_processors] =

(* Total spares under consideration for "processors" *)

|UC_processors;

START =

(

(El_processors OF TRUE), (e Each working in "processors" e)

(gI_processors OF FALSE), (* Each permanent failed in "processors" *)

(SI_proceanors OF FALSE), (* Each transient fanlty in "processors" .)

|SI_processors, (. dedicated Working spares count, "processors" *)

O, (* dedicated Failed spares count, "processors" ,)

(|__memories OF TRUE), (* Each working in "memories" *)

(El_memories OF FALSE), (* Each permanent failed in "memories" *)

(II_momories OF FALSE), (* Each transient faulty in "memories" *)

II_bus, (* Count of working in "bus" *)

O, (* removed components *)

O (e |umber of component failures for PRUgEIF e)
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);

ASSERT ITOT "

COUlT(g.procossore) +

COUIT(FP.procossors) +

COUlT(FT_procossors) +

COUlT(W_m*morlss) +

COUIT(FP.memorlos) +

COUIT(FT_mmorios) +

El_bus +

IgS_proceesor8 +

IFS_processors +

TRASH_CAI_SIZE;

(*

*)

Assertions for component "processors"

ASSERT TA_procsssors >= TgA_proconore;

ASSERT TA_processors >= TFA.procoesors;

ASSERT (TWA.proceeeore + TFA.processors) <= El_processors;

ASSERT (TVA_procsssors + TFA.procossors) = TA_procossors;

(*

*)

For each part in component "processors"

.......................................

FOR ix II [1..El_processors]

ASSERT A.processors(Ix) OR (10T U_processors[Ix]);

ASSERT COUlT(FP_procsssors[ix]) + COUlT(FT_procsssors[ix]) <= 1;

ASSERT COUJT(W_procsssors[ix]) +

COUIT(FP_procsssors[ix]) + COUET(FT_procenors[tx])

<= 1;

(*

*)

Fault Arrivals for component "processors"

.........................................

IF (R_processors[ix]) THEE (* Fault arrivals *)

(*
* Permanent fault arrivals

........................

.)

TRABT0 _-pr_c_s_rs[ix]=FALSE,F_-pr_c_ss_rs[ix]=_1kUE_FT-pr_cess_rs[ix]=FT-_r_c_s_rs[_x],

ICF++

BY L_P_processors; (* Permanent fault arrival ,)
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(e

e

e

*)

Transient fault arrivals

........................

TEA|T0 M-pr_csss_rs[i_]=FALSE_FT-_r_cus_rs[ix]=TRUE_F_-pr_c_ss_rs[ix]=F_-pr_ceuors[ix],
ECF++

BY L_T_processors; ($ Transient fault arrival s)

ENDIF;

IF (FT_processors[ix]) (e Transient faults go permanent e)

TRANTO FT_processors[ix]=FALSE,FP_procsssors[ix]=TaUE,

NCF++

BY L_P_processors; ($ Transient to Permanent fault arrival $)

(e

$

$

*)

Transients disappear for "processors"

.....................................

IF (FT_processors[ix]) THEN ($ Transient faults $)

TRAIT0 FT_processors[Ix]=FALSE,W.processors[ix]=TRUE

BY FAST DIS_processors; (e Transient disappears e)

EEDIF;

(e

$

$

*)

Grab a spare for "processors" fault

...................................

IF (FT_proceseors[ix]) THEE ($ Transient faults $)

IF (lUC_processors > O) TEEN (e Try dedicated spares for "processors" first $)

IF (WHS_processors > O)

TEA|TO NHS_procsesors--,FT.procusors[ix]=FALSE,W.processors[Ix]=TRUE,

TEASH_CA|_SIZE++

BY FAST (PEW_processors)eR.S_processors;

E|DIF;

E|DIF;

IF (FP_processors[ix]) THE| (* Permanent faults e)

IF (EUC_processors > O) THEN ($ Try dedicated spares for "processors" first e)
IF (|WS_processors > O)

TRANTO NWS_processors--,FP_processors[ix]=FALSE,W_proceeeors[ix]=TRUE,

TRASH_CAN_SIZE++

BY FAST (PEW_processors)*R_S_procsssors;
ENDIF;

ENDIF;

(e

$

$

e)

Degrade component "processors"

..............................

IF (FA_processors(ix)) AND (TUC_processors = O) THEE
(*

$ degrade by one
*)

IF (FP_processors[ix]) THE|

IF (ix = 1) THEN

IF (W_memories[1]) THE| (e able to: WRM(msmories[1]) e)

TEA|TO FP_processors[1]=FALSE,

W_memoriss[1]nFZLSE (e 81: KEN(processors[I]) m) WRg.KEN(memories[1]) $),
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TEASH_CA|_SIZE=Ti_SH_CAM_SIZE+2

BY FAST E.D_processors;

EBDIF;

IF (FP_memories[1]) THEM (e able to: pM(menories[l]) e)

TJ_HTO FP_processors[l]=F_SE,

FP_momories[1]nFALSE (e 71: m(processors[1]) -> PIWq.UIq(momorios[1]) e),

TEASH_CAB_SIZEmTRASH.CAB_SIZE+2

BY FAST K_D_processors;

EBDIF;

IF (FT_momories[l]) THEH (e able to: TRH(monortos[1]) e)

TRAITO FP.procossors[1]mFALSE,
FT_menorlesEI]=FALSE (* 81: KKH(proceasors[1]) -> TIUq.IKMCnenorlos[l]) e),

TEASH_CAM_SIZE=TRASH.CAH.SIZE+2

BY FAST E_D_processors;

EBDIF;
IF (TA_memories <= O) THKII (o not able to: EEM(memorles[1]) o)

TEASTO FP_procsssors[l]nFALSE,

TKASH.CAE_SIZK++

BY FAST E_D_processors;

EHDIF;

ELSE IF (ix = 2) THEM

IF (W.momorios[2]) THE| (e able to: HRH(momorios[2]) o)

TEAMTO FP_processors[2]=FALSE,

g.mamories[2]=FALSg (e S2: NEE(processors[2]) -> WlR.KKN(nemories[23) e),

TILkSH.CAH_SIZE=T1LqSH.CAB_SIZE÷2

BY FAST E_D_processors;

EBDIF;

IF (FP_memorios[2]) THEE (* able to: PEMCmomorios[2]) e)

TRAHTO FP.procossors[2]=FALSE,

Fp.nemorLos[2]=FALSE (e 12: IW_H(procossors[2]) -> pPJq.l_H(mmwries[2]) o),

TRASH_CAI_SIZE=TRASH_CAJ_SIZE+2

BY FAST E_D_processors;

E|DIF;

IF (FT_nenories[2]) THEY (e able to: TEE(memories[2]) e)

TEAITO FP_processors[2]=FALSE,

FT_memories[2]=FALSE (e #2: MEN(processors[2]) -> TlJI.REN(memorles[2]) e),

TRASH.CAM_SIZE=TRASH_CAII.SIZE÷2

BY FAST R_D_processors;

ESDIF;

IF (TA_nsmories <= O) THEM (* not able to: EEE(memories[2]) e)

TEAHTO FP_procossors[2]=FALSE,

TRASH_CAB_SIZE++

BY FAST E_D.processors;

EBDIF;

ELSE IF (ix = 3) THEM

IF (M_memories[3]) THEM (* able to: WRN(momorisa[3]) e)

TRABTO FP.procossors[3]=FALSE,

W_memorlos[3]=FALSE (e 13: EEH(procossors[3]) -> HRN.REH(nomoriss[3]) *),

TEASH_CAM_SIZE=13JtSH_CAM.SIZE+2

BY FAST E.D.processors;

ESDIF;

IF (FP.memories[3]) THEM (0 able to: PRM(momories[3]) e)

TRAMTO FP_procoesors[3]nFALSE,

FP_momories[3]=FALSE (e S3: SEN(processors[3]) -> PEH.PJ_q(memorios[3]) e),

TRASH_CAE.SIZEaTRASW_CAE_SIZE+2

BY FAST R_D_processors;

E|DIF;

IF (FT_momorios[3]) THEE (e able to: TEE(memories[3]) o)

TEA|TO FP.processors[3]=FALSE,

FT_menorios[3]=FALSE (* 13: SEN(processors[3]) -> TRN.lWEH(momoriea[3]) e),

TEASE_CAM_SIZEmTRASH_CAE.SIZE+2

BY FAST E_D_processors;

EEDIF;

IF (TA.momories <= O) THEM (e not able to: SEN(memories[3]) e)
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TRARTO FP_processore[3]=FALSE,

TEASR_CAI_SIZE÷+

BY FAST R_D_processors;

EMDIF;

EEDIF; ENDIF; EEDIF;

ENDIF;

IF (FT_processors[ix]) THEE

IF (ix = 1) THEM

IF (W_memorios[1]) THEN (e able to: WRR(memories[1]) e)

TRARTO FT_proceesore[l]=FALSE,

W_memories[l]=FALSE (e 11: KEN(processors[l]) -> YRN.REM(Nmories[I]) e),

TRASH_CA|_SIZE=TRASH_CAB_SIZE÷2

BY FAST R_D_processors;

EEDIF;

IF (FP_memorlos[1]) THEM (e able to: PRH(menorlee[l]) e)

TRARTO FT_processors[1]=FALSE,

FP_memories[1]=FALSE (* 11: KEN(processors[I]) -> PRM.REN(nemorles[1]) e),

TRASH_CAN_SIZE=lltASR_CAM_SIZE÷2

BY FAST R.D_processors;

EMDIF;

IF (FT_memoriee[l]) THEN (e able to: TRM(memorlos[1]) e)

TRAMTOFT_procossors[I]=FALSE,

FT_momorios[1]nFALSE (* 11: KEN(processors[I]) -> TER._ER(memorles[1]) e),

TRASH_CAM_SIZEmTRASH_CAH_SIZE+2

BY FAST R_D_processors;

EMDIF;

IF (TA_memories <= O) TREE (e not able to: REM(nenories[l]) e)

TEAETOFT_proceesors[I]=FALSE,

TRASH.CAM.SIZE÷÷

BY FAST R_D_procossore;

EMDIF;

ELSE IF (ix = 2) THEM

IF (W_memories[2]) THEE ($ able to: WEH(memories[2]) e)

TRARTOFT_processors[2]mFALSE,

W_memories[2]=FALSE (e 12: REN(processors[2]) -> WBR.BEH(_morles[2]) e),

TRASH_CAE_SIZEwTRASH_CAM.SIZE÷2

BY FAST R_D_processors;

EMDIF;

IF (FP_memories[2]) THEM (, able to: PRM(nemories[2]) e)

TRAETO FT_proceseors[2]=FALSE,

FP_memories[2]=FALSE (e 12: HEM(processors[2]) -> PRM.REH(momDrios[2]) e),

TRASH_CAE_SIZE=TRASR_CAN_SIZE÷2

BY FAST E_D_processors;

EMDIF;

IF (FT_monorios[2]) THEE (e able to: TRM(memorlee[2]) e)

TEASTO FT_processors[2]=FALSE,

FT_nemories[2]=FALSE (e 12: HEM(processors[2]) -> TPJq.REM(memorles[2]) e),

TRASH_CAB_SIZE=TRASR_CAH_SIZE÷2

BY FAST R_D_processors;

EMDIF;

IF (TA_memories <= O) THEM (e not able to: HEM(memories[2]) e)

TRAETO FT_proceeeors[2]=FALSE,

TRASH_CAN_SIZE+÷

BY FAST K_D_processors;

EMDIF;

ELSE IF (ix = 3) THEE

IF (H_memories[3]) THEN (* able to: gRM(memories[3]) e)

TEA|TO FT_processors[3]=FALSE,

W_memories[3]=FALSE (e 13: REN(processors[3]) -> HRN,REN(Nmories[3]) e),

TEASH_CAE.SIZE=TRASH_CAM_SIZE+2

BY FAST E_D_processors;

EIDIF;

IF (FP_memories[3]) THEM (e able to: PRR(memories[3]) e)

TRAITO FT_processors[3]=FALSE,
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FF.memories[3]=FILSE (o #3: IEll(proceseore[3]) -> pl_.]l_N(manories(3]) o),

TBASH_CAI_SIZE=TRASH_CA|.SIZE+2

BY FAST k_D_processors;

EIDIF;

IF (FT_momories[3]) THE| (e able to: TEJq(memoriss[3]) e)

TRARTO FT_processors(3]uFALSE,

FT_mamories(3]=FALSE (e 13: RXN(processors(3]) -> TB/l.RKN(nsmorlss(3]) e),

TRASH_CA|.SIZE=TRASH_CA|.SIZE÷2

BY FAST R_D_processors;

EIDIF;

IF (TA_msmorios <= O) THEE (e not able to: RSN(memories(3]) e)

TKAITOFT.processors[3]=FALSE,

TRASH.CAR.SIZE÷v

BY FAST E.D.processors;

ERDIF;

E|DIF; E|DIF; EIDIF;

E|DIF;

E|DIF;

EIDFOE;

(m

e

e

e)

Assertions for dedicated "processors" spares

............................................

ASSERT IIUC_procossors <= IS.processors;

ASSERT (IVS.proceesors + IFS.proceeeore) <= |SI_processor8;

IF (lVS_proceseors > O) THEE (e Arrlval of "processors" spare fault e)

TRARTO SVS_proceeeors--.l_S_processore4_,|CF4_

BY IgS_proceesorseL_S_proceesors;

ESDIF;

(e

e

e)

General Death's for component "processors"

..........................................

DEATHIF TFA_processors >= TgA_processors; (e HAJ(processors) e)

(eeeeeeeeeeeeeeeeeeeeeeeeeeeeeeoee)

(eeeeeeeeeeeeeeeeeeeeeeeee_eeeese)

(*** .oe)

(me. COHPOIEIT: "memories" moo)

(*** ...)

***********************************

(,eeeee.e**eeee,eeeeeeeeeeeeeeeeee)

(*

e

e

*)

Assertions for component "memories"

...................................

ASSERT TA_momorioe >= TEA_memorise;

ASSERT TA_mosorise >= TFA_memortes;

ASSERT (TVl_memories + TFA_momories) <= IT_memories;

ASSERT (TWA_memoriss + TFA_msmories) = TA.memorios;

(*

e

e

For each part in component "memorlos"

.....................................
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*)

FOR ix II [1..|I.memories]

ASSERT A_memories(ix) OR (JOT g_memories[ix]) ;

ASSERT COUlT(FP_memories[ix]) + COUJT(FT.momoriss[iz]) <= 1;

ASSERT COUBT (W_memories [ix]) +

COUNT(FP_m.mories[ix]) + COUIT(FT.memoriss[ix])

<= 1;

(e

e

e

e)

Fault Arrivals for component ,,memories"

.......................................

IF (V_memories[ix]) THEE (e Fault arrivals s)

($

• permanent fault arrivals

$ ........................

*)

TRAETO V_memories [ix] =FALSE ,FP_memoriss [ix] mT]LUE ,yT.atomor_os [_z_ oFT.stele•ties (ix],

ECF++

BY L_P_memories; (e permanent fault arrival s)

, Transient fault arrivals

• ........................

*)

TRABTO W_memor ies[ix]=yALsR'FT-mem°risa[ix_=TKUS'yP'mem°rios[ix]uFp'nejtOries[ix]'

ICY++

BY L_T.memories; (* Transient fault arrival *)

EEDIF;

IF (FT_memories[ix]) (e Transient faults go permanent e)

TKAITO FT-mem oriss[ix]=FALSE'FP-mom°rios[tx]mTKUE'

|CF++

BY L_P_memories; (• Transient to Permanen_ fault arrival •)

(•

e

*)

Transients disappear for "memories"

IF (FT_memories[ix]) THEE (* Transient faults e)

TKABT0 FT.memories[ ix]=FALSE'V-mem°ries[ix]=TKUE

BY FAST DIS_memories; (e Transient disappears e)

EBDIF;

(e

e

*)

memorles"
Degrade component "

IF (FA_memories(ix)) THE|

(*

• degrade by one

*)

IF (FP_memories[ix]) THE|

TRABTO FP_memoriee[ ix]=FALSE,
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TgASH_CAI.SIZE¢4

BY FAST EoD_momorios;

EIDZ F;

IF (FT_momorioa[ix]) TIIEI

TRA|TO FT_menories [ix] mFALSK,

TRASR.CA]_SI ZE++

BY FAST It_D_mamories;

EBDIF ;

KIDIF ;

EIDFOE;

(*

• flonoral Doagh_n for ¢omponong "momories"

*)

DEATHIF TFA.momorios >= TMA_nemories; (* MAJ(momorios) *)

(*** ***)

(*** CORPOlmi'T: "bus" ***)

(,,* ***)

(•

*)

Assertions for component "bus"

..............................

ASSERT TA_bus >= TMA.bus;

ASSERT TA_bua >= TFA_bus;

IF (|M_bus > O) (* Fault arrivals *)

TRA|TO EM_bus--,

ICF÷*

BY SW_buaeL_P_bua; (* Permanent tault arrival *)

(•

*)

Oeneral Death's for component "bus"

...................................

DEATHIF TFA_bus >= TMA_bus; (* NAJ(bus) *)

PRUEEIF |CF > Prune_ATtar;
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